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Caution: Never 
onne
t this instrument to the AC line. Doing

so may result in personal injury and extreme damage to the

operator, the instrument and to an atta
hed 
omputer. See

se
tion 11 on page 26.
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Figure 1: The CGR-201 Graphi
al User Interfa
e

1 Overview

The Sys
omp Cir
uitGear MkII (CGR-201) is a 
ombination of three ele
troni
 instruments: a two-


hannel digital storage os
illos
ope, a waveform generator, and a digital input-output port. Host software


an operate the instrument as a spe
trum analyser and as a ve
tor-network analyser (Bode plotter).

Cir
uitGear in
ludes a small hardware module and display software that runs on a host PC. Figure

1 shows the user interfa
e.

The CGM-101 is a development based on the su

essful Cir
uitGear produ
ts CGR-101 and CGM-101

with many enhan
ements and additional features.

The initial release of the CGR-201 in
ludes enhan
ed features of the CGR-101 Cir
uitGear and

CGM-101 Cir
uitGear Mini. The hardware supports additional features and these will be added with

subsequent �rmware and software releases.

1.1 Os
illos
ope

The os
illos
ope is a dual-
hannel, 40MSample/se
 os
illos
ope with 10 bit A/D 
onversion, digital

storage and display.

Channels A and B are sampled simultaneously and stored in the os
illos
ope memory before being

sent for display to the host 
omputer. Consequently, the signals are always time aligned and asso
iated

with the same trigger signal. Triggering is a

omplished by digital 
ir
uitry so it is pre
ise and 
onsistent.

Trigger 
ontrols in
lude Mode: Auto, Normal, Single-shot, Manual, Sour
e: A or B, and Slope: Positive

or Negative.
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The time at whi
h the trigger o

urs is 
ontinuously adjustable by adjustment of an on-s
reen 
ursor

so that the operator 
an display the signal before and/or after the trigger event.

The os
illos
ope timebase frequen
y is derived from a 
rystal os
illator, so it 
an be expe
ted to be

pre
ise and stable. The displayed amplitude is determined by 1% resistors and analog-digital 
onversion.

The verti
al preampli�er is gain-swit
hed to optimize the signal-noise ratio and will a

ept x10 and x100

s
ope probes.

1.2 Waveform Generator

The waveform generator is a dire
t-digital synthesis (DDS) based devi
e with frequen
y range between

0.05Hz and 10MHz (sine wave) with a frequen
y resolution of 0.05Hz. The frequen
y 
an be adjusted,

without range swit
hing, over that entire range or some part of that range.

The usual sine, square, triangle and sawtooth waveforms are supplied with the instrument. The

generator 
an also load and produ
e an arbitrary waveform. Waveforms are nominally 8 bits (1:256)

verti
al resolution at all amplitude settings, and 2048 points in length.

For a
ousti
al measurements and other tone-burst appli
ations, the waveform generator is triggerable

from an external signal and 
an be 
on�gured to generate a series of one or more 
y
les ON time followed

by adjustable number of 
y
les OFF time.

1.3 Digital Input-Output

The digital I/O se
tion in
ludes an 8 bit output port and 8 bit input port. Outputs are 
ontrolled by 8

GUI buttons. Inputs are displayed on 8 GUI indi
ators.

In addition, there is a pulse generator output whi
h is 
ontinuously variable over the same range as

the waveform generator, with 
ontinously adjustable duty 
y
le.

In 
ombination, these 
ontrols form the basis for digital 
ontrols and displays for basi
 digital exer
ises

or more advan
ed 
ontrol systems.

1.4 Ve
tor Network Analyser (Bode Plotter)

For automati
 sweep, a Ve
tor Network Analyser (VNA) (aka Bode Plotter) program is available. The

VNA software operates the os
illos
ope and generator se
tions in 
on
ert to sweep a network over a

spe
i�ed range and plot the amplitude and phase of the response.

1.5 Spe
trum Analyser

A frequen
y spe
trum of the input signal 
an be shown at the same time as the time-domain waveform

display on the os
illos
ope s
reen. The spe
trum display is generated by the Fast Fourier Transform

algorithm, so that it responds instantaneously to 
hanges in the input waveform. This is ideal for

demonstrating the relationship of signals in the time and frequen
y domains.

1.6 General

The hardware is in a po
ket-sized pa
kage that 
an easily be 
arried in a student ba
kpa
k or with a

laptop 
omputer. Power and 
ontrol signals are provided to the hardware via a single serial-emulated

USB 
onne
tion with the host PC. An external power module (wall-wart) is not required.

The PC host displays a graphi
al user interfa
e for the os
illos
ope with frequen
y readouts, sliders,


li
kable buttons and various other 
ontrols. Ea
h instrument appears in its own window: unused

instruments 
an be minimized. The s
reen of the os
illos
ope is resizeable.

The hardware is entirely 
ontrolled by software: there are no ele
tro-me
hani
al swit
hes or adjust-

ments. This makes the hardware very reliable and supports development of 
ustom 
ontrol software in

OEM appli
ations.

The GUI software is written in the T
l/Tk language. The software is open sour
e and entirely in

T
l/Tk. The GUI software will operate under Linux, Ma
 or Windows operating systems. T
l/Tk is an

open-sour
e, interpreted language, so reading and modifying the sour
e 
ode is straightforward.
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The appli
ations programming interfa
e (API) is do
umented, so the hardware 
an be a

essed

by other 
omputer programs and languages. The only requirement is that the language be able to


ommuni
ate with a serial port.

1.7 Software Updates and Help

The Cir
uitGear manual in .pdf format is available from the Help menu. Cli
king on that menu item

automati
ally invokes A
robat Reader.

The software 
he
ks the Sys
omp website and advises if there is a later version of the software. You


an do that manually by sele
ting Che
k for Update in the Helpmenu. Alternatively, you 
an 
on�gure

the software to do that automati
ally every time it starts. Sele
t the Che
k for Updates on Startup

menu item.

The Change Log (re
ord of 
hanges with ea
h version) is available as a Help menu item.

2 Appli
ations

In addition to the usual operation of os
illos
ope and signal generator, here are some possible appli
ations

of the Cir
uitGear unit.

• Logi
 Net The digital 
ontrols supply the fun
tionality of a digital Exer
iser Unit, whi
h 
an

apply a stimulus to a digital 
ir
uit and measure the output.

For example the 8 bit digital lines 
an be used as inputs and indi
ators for a logi
 net. Students

set up various 
ombinations of input signals to the net and re
ord the outputs to generate logi


equations or a truth table for the logi
 net.

• State Ma
hine Exer
iser A single manual output line and the PWM output 
an be used as

a pulser for 
ounter and state ma
hine 
ir
uits. The manual output exer
ises the 
ir
uit at low

speeds, where the behaviour 
an be observed on the GUI indi
ators. The PWM output is then

used to operate the 
ir
uit at higher frequen
ies, and the os
illos
ope 
an be used to observe faster

events.

• Mixed Analog and Digital Cir
uits The digital outputs 
ontrol a MDAC (multiplying D-A


onverter) whi
h sets the 
entre frequen
y of a bandpass �lter. The generator and os
illos
ope

fun
tion as a Ve
tor Network Analyser, showing how the frequen
y response 
hanges as the digital

value is adjusted.

• Swit
hing Power Supply The PWM output 
ontrols a power MOSFET and LC network whi
h

fun
tions as a simple swit
hing power supply. Similarily, PWM output 
an modulate the power to

a DC motor as a simple method of speed 
ontrol.

• PWM DAC It is 
ommon for the PWM output of a mi
ropro
essor to be used as the basis

for a low-
ost digital-analog 
onverter. The PWM signal is �ltered to produ
e a variable analog


ontrol signal. In this exer
ise students design the PWM �lter and then measure the ripple using

the Cir
uitGear os
illos
ope. They 
an also operate the PWM signal at various frequen
ies to

illustrate the e�e
t of frequen
y on ripple.
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3 Features and Spe
i�
ations

The features and performan
e spe
i�
ations are as follows:

Os
illos
ope

Channels 2 independent 
hannels sampled simultaneously

Sampling Frequen
ies 40 MSamples/se
ond maximum

Verti
al Resolution 10 bits per 
hannel (1:1024)

Verti
al Bandwidth Greater than 5MHz

Verti
al Input Range ±100mV to ±25V full s
ale

Verti
al Gain Settings 7 settings, 20mV/div to 5V/div, in 1:2:5 sequen
e

Verti
al Coupling AC or DC 
oupling

Verti
al O�set Full s
reen, ±20V max

Verti
al S
ale 10 major divisions

Horizontal Time Settings, Timebase Mode 21 settings in 1:2:5 sequen
e

100mSe
/div to 50nSe
/div

Horizontal Time Settings, Strip Chart Mode 7 settings in 1:2:5 sequen
e

200 mSe
/div to 20 se
onds/Div

Horizontal S
ale 10 major divisions

Input Impedan
e 1M Ohm parallel 27pF

Triggering Digital 
omparison with input signal

Trigger View Pre and Post trigger simultaneously viewable

Trigger Controls Sour
e (A, B, Manual), level and slope sele
t

External Trigger Out Rear panel, sour
e 
hannel A, logi
 level

External Trigger In Rear panel, logi
 level signal

Memory Depth 4K Samples ea
h 
hannel

Software Cursor Readouts

Spe
trum Analysis (FFT)

X-Y Plot

Waveform math (Add, subtra
t, multiply)

Data re
ord to CSV �le (os
illos
ope and VNA plot

Save/Load Settings

Cursor Readouts

Auto Measurements

Verti
al Calibration

O�set Calibration

Waveform Generator

Frequen
y Range 0.1Hz to 10MHz (sine wave)

Output Waveform Amplitude +/-3.0V

Amplitude Control Hardware

Output O�set Control +/-2.5V

O�set Control Hardware

Verti
al Resolution 8 bits at all amplitude and o�set settings

Output Impedan
e 50 ohms

Waveforms Sine, Square, Triangle, Ramp, Arbitrary

Arbitrary Waveform 8 bit resolution verti
al, 1024 time points

Digital I/O

Output 8 bits, GUI (Graphi
al User Interfa
e) 
ontrolled, 5 volt, HCMOS

Input 8 bits, GUI indi
ators, 5 or 3 volt, HCMOS

Pulse waveform Variable frequen
y, 1Hz to 1MHz in steps of 1Hz

Variable duty 
y
le, 0 to 100% in steps of 1%
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Other

Indi
ators Power LED (Green)

A
tivity LED (Red)

Interfa
e USB 2.0: Emulated serial port

Physi
al Dimensions 8
m W x 2.4
m H x 12.5
m D

3.1in W x 1in H x 5in D

GUI Sour
e Code T
l/Tk language

Open sour
e, OSI Compliant

Windows, Linux, Ma
 operating systems

Current Consumption 400mA (approx)

4 Installation and Operation

On
e the software is installed and operational, starting the CGM-101 is a matter of plugging in the

hardware to a USB port, and 
li
king on the software i
on (or exe
uting a 
ommand line instru
tion).

This applies to all operating systems: Windows, Ma
 OS-X, Linux.

The installation pro
edure is brie�y des
ribed in se
tion 16, page 34 and in more detail in se
tion 17

on page 35.

5 Os
illos
ope

The os
illos
ope Graphi
al User Interfa
e (GUI) is shown in �gure 2.

Figure 2: Os
illos
ope GUI

Many of the s
ope 
ontrols are similar in fun
tion to those of the 
lassi
 analog os
illos
ope. Other


ontrols are unique to the CGM-101. They provide fun
tions - su
h as 
ursor readouts - that are only

possible in a digital os
illos
ope.

The s
ope 
ontrols divide into various groups: amplitude, timebase, display and triggering.
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5.1 Amplitude

There are two input 
hannels, A and B, ea
h with identi
al 
ontrols.

• S
ale Sets the verti
al s
ale fa
tor of the display between 20mV per division and 5 volts per

division in the traditional os
illos
ope 1:2:5 sequen
e. The amplitude may be read o� the display

by measuring the number of divisions and multiplying by the s
ale fa
tor. Alternatively, the display

amplitude 
ursors may be used (see display below.)

Changes to the s
ale 
ontrol adjust the sensitivity of the front-end of the os
illos
ope, adjust the

preamp gain and 
hange the software s
ale fa
tor.

• Option This button opens a sub-menu, with the following 
ontrols:

� Coupling, DC and AC This swit
h 
ontrols the input 
oupling of the os
illos
ope. In

the DC position, the signal is 
oupled dire
tly into the os
illos
ope preampli�er, so that all


omponents of the signal are displayed.

In the AC 
oupling position, the signal is passed through a 
apa
itor, so that the DC 
om-

ponent of the signal is removed. This is parti
ularly useful when you are trying to observe a

small AC signal sitting on a larger DC 
omponent. If the input is DC 
oupled, In
reasing the

verti
al sensitivity in
reases size of the AC 
omponent, but also sends the AC 
omponent o�

the s
reen. When AC 
oupling is sele
ted, the AC 
omponent 
an be magni�ed and viewed

without shifting.

Warning Our re
ommended maximum input voltage on the AC 
oupling setting is 40 volts

DC. Ex
eeding this may 
ause damage to the ele
troni
 swit
h that sele
ts between AC and

DC 
oupling. You 
annot use the AC setting to blo
k DC voltages larger than this value. (For

example, in audio tube ampli�ers, DC voltages of 350 volts or higher are not un
ommon.)

If you need AC 
oupling where the DC 
omponent of the signal is larger than 40 volts,

you should put the 
oupling in the DC position and 
onne
t an external 
apa
itor of the

appropriate voltage rating in series with the input.

The AC 
oupling position rolls o� frequen
y response below a 
uto� frequen
y, whi
h is given

by:

fc =
1

2πRC

The resistan
e is 1MΩ. The internal 
apa
itor is 100nF, giving a low-frequen
y 
uto� of

1.5Hz.

� Hide This sele
tion allows one to hide a tra
e that is not in use, in order to redu
e s
reen


lutter.

� Invert This sele
tion inverts the display. This is most useful in 
onju
tion with the 'Add

waveform' display. Inverting one 
hannel and adding the two inputs 
reates a display of the

di�eren
e between the two signals.

� Probe ×1, ×10, ×100 These settings adjust the verti
al s
ale fa
tor to mat
h the s
ale fa
tor

of the probe. For example, if you are using a ×10 setting on the os
illos
ope probe and sele
t

×10 in this 
ontrol, the displays and s
reen s
ale fa
tors will 
hange appropriately.

5.2 Os
illos
ope Mode: Timebase

The timebase has two modes of operation: os
illos
ope mode and strip
hart mode. Os
illos
ope mode is

most suitable for displaying rapidly 
hanging events. For example, it is possible to 
apture and display

the transient voltage from the 
losing of an ele
trome
hani
al swit
h. Strip
hart mode is suitable for

re
ording slowly 
hanging events. It mimi
s the behaviour of old-fashioned pen re
orders that were used

for re
ording su
h phenomena as earthquake waves or 
hanging temperature.

The timebase 
hanges automati
ally from os
illos
ope mode to strip
hart mode at the timebase

settings 100 to 200mSe
 per division. During os
illos
ope mode, the timebase interval shows Sampling,
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to indi
ate that a sampling os
illos
ope is in operation. During strip
hart mode, the timebase interval

shows S
an.

In os
illos
ope mode, the trigger fun
tions (se
tion 5.4) are operational. On the o

urren
e of a

trigger signal, the os
illos
ope hardware 
aptures samples into a bu�er, and then ships them to the

host 
omputer for display. The 
omplete 
apture-display sequen
e happens, as in a 
onventional analog

os
illos
ope, several times per se
ond.

TheMain Time Base (MTB) 
an be varied between 100mSe
/division 500 nSe
/division and 100mSe
/-

division in the traditional os
illos
ope 1:2:5 sequen
e.

5.3 Os
illos
ope Mode: Display

Refer to �gure 2 on page 6.

• Verti
al Position A waveform may be moved in verti
al position. At startup, the A and B


ursors - whi
h are the zero referen
e for the 
hannel � are pla
ed at 
entre s
reen. Using the

mouse, drag the letter A or B at the right edge of the display area up or down to 
hange the

verti
al position of the 
orresponding waveform.

Shifting the zero position of the tra
e is done by DC o�set of the input signal. This ensures that

the full s
reen height is available for display at all settings of the shift 
ontrol.

• Time Cursors It is possible to enable and disable various time and amplitude 
ursors.

Right 
li
k in the display area. A menu appears:

Toggle Time Cursors Left Cli
k to enable and disable verti
al 
ursor lines that mark the

time between two lo
ations on s
reen.

Toggle Channel A (or B) Cursors Left Cli
k to enable and disable horizontal 
ursor lines that mark

the amplitude between two lo
ations on s
reen.

Grid Left Cli
k to sele
t the appearan
e of the grati
ule grid in the

display area: enable and disable the display of the grid, or 
hange


olours of the grid lines.

Noti
e that the 
ursor readout text 
an be dragged to di�erent positions on the s
reen. This is

useful when setting up a s
reen display for 
apture in a do
ument.

• Resizing

Drag the bottom right 
orner of the os
illos
ope display area to 
hange the size of the display. This

is parti
ularly useful for tea
hing and lab demonstrations, where the CGM-101 display is proje
ted

on an overhead s
reen, as shown in �gure 3.

5.4 Os
illos
ope Mode: Triggering

In order to present a stable waveform display, ea
h display update must start at the same point on a

waveform. The trigger fun
tions determine how that trigger point on the waveform is sele
ted.

The trigger 
ontrols must meet 
ertain requirements in order to generate trigger signals for waveform


apture. If these 
ontrols are not set properly, it is possible that the s
ope will not 
apture waveforms and

the display will appear to be frozen. Alternatively, the display may appear to jump between 
aptures,

without a stable waveform display.

• Trigger Level

The trigger level is marked by a horizontal green 
ursor with a T symbol at the leftmost edge of the

s
reen (�gure 4 on page 10). The trigger level may be dragged verti
ally to set the amplitude on a

waveform that establishes the trigger point. In order to 
ause triggering, the triggering waveform

must 
ross through the trigger 
ursor level.

As the trigger level 
ursor is dragged, an a

ompanying readout displays the trigger level in volts.
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Figure 3: Enlarged S
reen

• Trigger Mode: Auto/Normal/Single

� In the Normal position, the s
ope hardware must get a proper trigger signal in order to

display a new waveform. Without a trigger signal, the display simply waits. (The Manual

Trigger button 
an be used to for
e a trigger event, that is, display one 
apture.)

� In theAuto position, if there is a trigger signal, the s
ope uses the trigger signal to syn
hronize

waveform 
apture. If there is no trigger signal the s
ope hardware waits for a period of time

and then generates a trigger signal internally. That way, there are periodi
 updates to the

waveform display, even if triggering is not o

urring from an input waveform.

In general, the most 
onvenient position is Auto. However, there are two situations where

Normal triggering is ne
essary:

∗ For very low frequen
y waveforms, the trigger signals o

ur infrequently. If Auto trig-

gering is enabled, the s
ope will de
ide that trigger signals are not present and generate

them internally. This is not what is wanted: the s
ope should wait for a waveform trigger

signal.

∗ If the s
ope is being used to 
apture a single-shot event, then it should not trigger itself:

it should wait for a waveform trigger signal, regardless of how long it takes for that trigger

signal to o

ur.

� In the Single position, the s
ope waits for a trigger signal. (This is known as the Armed

state.) When a trigger signal o

urs, the software 
aptures and displays that waveform and

disables further triggers. The Single-Shot Reset button 
lears the display and returns the

s
ope to the Armed state.

• Manual Trigger A
tuating this button generates a trigger signal. This is sometimes useful to


ause the s
ope to 
apture one waveform.

• Trigger Options

The Options trigger menu leads to the following 
ontrols:
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� Trigger Sour
e

The trigger signal may be derived from the Channel A waveform or the Channel B waveform.

Generally, it is easier to obtain a stable trigger signal from the simpler of the two waveforms.

� Trigger Slope

The trigger slope 
ontrol sele
ts a positive-going or negative-going slope at the trigger point.

This allows one to trigger o� the leading or trailing edge of a positive pulse waveform, for

example. An slope symbol on the GUI in the Trigger area shows the 
urrently sele
ted slope.

• Trigger Hysterysis Display

Figure 4: Trigger Cursors

Noise on the triggering signal 
an 
ause mis-triggering and jitter. To prevent this, there is a

hysterysis band asso
iated with the trigger level T. Referring to �gure 4, the hysterysis band is

de�ned by an upper trigger hysterysis level TH and a lower trigger hysterysis level TL. All three

trigger 
ursors 
an be dragged verti
ally.(TH must always be above the trigger level 
ursor, and

TL must be below the trigger level 
ursor.)

A positive-going trigger signal must 
ross through both the upper trigger hysterysis level and then

through the lower trigger hysterysis level.

Normally, there is no need to adjust the hysterysis band, and you 
an leave it at its default settings.

However, for a noisy signal it may help to in
rease the hysterysis band.
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5.5 Measurements S
reen

The Measurements S
reen shows 
ursor and automati
 measurements of the most 
ommon features of a

waveform: amplitude and time.

Figure 5: Measurements S
reen

As shown in �gure 5, the Measurements S
reen is in a separate window. This window defaults to

being displayed, that is, it is displayed when the program is �rst started.

The Measurements S
reen may be hidden by 
li
king on the X in the upper right 
orner of the

measurements window. It may be displayed by 
li
king on the menu item View -> Auto Measurements.

The Measurements S
reen shows the Auto Measurements, in whi
h the software automati
ally mea-

sures waveform parameters. The Frequen
y and Period readouts are based on the zero-
rossings of

the waveform. Consequently the waveform must be periodi
 and the main display must show at least

one 
omplete 
y
le of the waveform for the frequen
y and period values to be meaningful. As well, the

frequen
y and period measurement 
an be fooled if the waveform in
ludes noise that 
auses multiple

spurious zero 
rossings.

The RMS measurement requires that the time 
ursors be visible and set to the beginning and end of

one 
y
le. This is required to de�ne the limits of integration in the RMS 
al
ulation.

For multiple measurements on a reasonably 
lean waveform, the Auto Measurements 
an be a real

time saver. However, it is best to verify that the measurement is reliable before relying on it extensively.

5.6 XY Mode

The usual os
illos
ope display shows a plot of the two signal amplitudes, voltage on Channel A and

Channel B, vs time. It is also possible to plot the two voltages against ea
h other: Channel A as the X

axis and 
hannel B as the Y axis.

Sele
t View -> XY Mode to enable the XY display.

The CGR-101 
an simultaneously display both the XY display and the 
onventional voltage-time

waveforms, whi
h is useful in tea
hing situations and for debugging purposes. If you wish to hide

the 
onventional waveforms, and just show the XY display, disable the individual 
hannels using the

Enable/Disable button.

Lissajous Figures

When the two signals are sine waves of the same frequen
y, with a phase shift between them, the display

is as shown in �gure 6. This type of looping display is known as a lissajous �gure.
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Figure 6: XY Display Mode

If the two frequen
ies di�erent but integer multiples of ea
h other, then the lissajous �gure will have

multiple nodes. In the early days of os
illos
opes, lissajous �gures were used in this manner for frequen
y

measurement. The verti
al ampli�ers of the day 
ould not work at high frequen
ies, so the signals were

applied dire
tly to the de�e
tion plates of the 
athode ray tube. The lissajous �gure gave an indi
ation

of frequen
y ratio and relative phase.

To form a 
omplete lissajous loop, the timebase setting must be su
h that both waveforms show at

least one 
omplete 
y
le.

Magnitude Measurement

If the two signals are exa
tly in phase, the XY plot is a straight line. If the two signals are of exa
tly

the same magnitude, the angle of the straight line is 45◦. If the magnitudes are di�erent, then the line

is at some other angle. This is a sensitive method of 
omparing the amplitude of two waveforms, whi
h

need not be sine waves. Any waveshape should fun
tion in this measurement.

General Purpose Plotting

The XY Mode display may be used for a variety of appli
ations where a plot of some kind is required.

Figure 7 shows an example. The CGR-101 has been 
on�gured to plot the voltage-
urrent 
urve of a

sili
on diode. Noti
e that the diode threshold is around 0.6 volts. The verti
al s
ale is voltage measured

a
ross a 
urrent sensing resistan
e, equivalent to 10mA per division.

5.7 S
reen Capture

It is extremely useful to be able to 
apture os
illos
ope s
reen shots. One or more s
reen shots may be

used to do
ument a parti
ular measurement situation as a re
ord of the measurement or to 
apture the

result for a larger do
ument.

Be
ause the instrument s
reens of the CGR-Mini are separate windows, it is possible to 
apture the

s
reen image of the os
illos
ope, the generator or the digital-IO se
tion to a s
reen image. Usually, one

is interested in 
apturing the os
illos
ope, showing the waveforms. This type of s
reen 
apture is useful

be
ause it also 
aptures the 
ontrol settings, whi
h is important for 
omplete do
umentation.

The various 
omputer operating systems use di�erent methods to 
apture to 
apture a window or

full s
reen.
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Figure 7: Diode Voltage-Current Chara
teristi


Windows XP To 
apture the entire desktop (multiple windows), press the Print S
reen keyboard

key. To 
apture a single window (su
h as the os
illos
ope), position the mouse 
ursor somewhere

inside that window and press the Alt and Print S
reen keys simultaneously.

Both these a
tions 
opy the s
reen image to a 
ut/
opy/paste bu�er.

To view the s
reenshot and save it to a �le, open

Programs -> A

essories -> Paint.

Inside paint, 
hoose the menu item Edit -> Paste and the image will appear in the Paint

workspa
e. Now you 
an save it to the dire
tory of your 
hoi
e, in the �le format of your 
hoi
e,

using the

File -> Save As

menu item. The pre
ise instru
tions for other Windows operating systems are similar to XP.

Ma
 Sue Chastain des
ribes several methods of s
reen 
apture on the Ma
.

http://graphi
ssoft.about.
om/od/s
reen
apturema
/ht/ma
s
reenshot.htm

Here's her method of 
apturing a spe
i�
 window (su
h as the os
illos
ope window).

To 
apture a spe
i�
 appli
ation window, press Command-Shift-4, then press the Spa
e-

bar. The 
ursor will 
hange to a 
amera, and you 
an move it around the s
reen. As you

move the 
ursor over an appli
ation window, the window will be highlighted. The entire

window does not need to be visible for you to 
apture it. When you have the 
ursor over

a window you want to 
apture, just 
li
k the mouse button and the s
reen shot will be

saved as a PNG �le on your desktop. (The �le is saved as PDF in Ma
 OS 10.3 and

earlier.)

Linux Under linux, s
reen 
apture is handled by the window manager. Under Suse Linux:

Similar to Windows, pressing the keyboard Prints
reen key 
aptures the entire desktop.

Alt-Prints
reen 
aptures the window where the mouse 
urrently resides.

A popup dialog box prompts you for the �le name and lo
ation to save the image. The image

is saved in .png format. Use the '
onvert' 
ommand to 
hange it to some other format, eg:


onvert foo.png foo.jpg

As one would expe
t from Linux, there are many other ways to 
apture a s
reenshot. Google will

help you �nd them.
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5.8 Aliasing

The os
illos
ope is a sampled-data-system. It works by taking a series of samples of the input waveform

and displaying them. However, when the signal 
ontains high frequen
y 
omponents 
ompared to the

sampling rate, the display may be in
orre
t. In theory, at least two samples per 
y
le of the highest

frequen
y present in the waveform are required to re
onstru
t the waveform 
orre
tly.

Some sampled-data-systems have a 
onstant sampling rate. For example, audio is typi
ally sampled

at 44.1k samples per se
ond. In that situation, usual pra
ti
e is to in
orporate a low-pass �lter su
h

that frequen
ies above 22 kHz are prevented from entering the system

1

Most � if not all � digital os
illos
opes do not in
orporate an anti-aliasing �lter. The sample rate of a

digital s
ope varies over a wide range of frequen
ies, and so the 
uto� frequen
y of the anti-aliasing �lter

would have to do so as well. Combined with the bandwidth requirement, that is a di�
ult te
hni
al


hallenge. Instead, the os
illos
ope relies on the operator to re
ognize when aliasing is o

urring and

in
rease the sample rate until the e�e
t disappears.

A useful strategy in measuring an unknown waveform is to approa
h it from a high sampling rate

(aka timebase setting) and redu
e the setting until a readable display appears. It is also required of the

operator to know (approximately) the frequen
y of the waveform that is being observed. That is often

the 
ase.

A useful rule of thumb is this: the display must 
ontain about 10 samples per 
y
le of the waveform

to re
onstru
t it. For this os
illos
ope the maximum sampling rate is 40MSamples/se
ond, so it 
an

usefully observe frequen
ies up to about 4MHz. The os
illos
ope preampli�er analog frequen
y response

has been designed to be 5MHz±0.2db to meet this requirement.

5.9 Interpolation

At high sweep rates, the number of sample points be
omes visible and the waveform 
onsists of line

segments between those points. Interpolation smooths the waveform and helps with the interpretation

of the waveform (�gure 8).

Interpolation is a

omplished by adding additional zero-value sample points between ea
h real sample,

and then passing the resultant sequen
e of points through a low-pass �lter. Interpolation must be used

with 
are: on a waveform with abrupt transitions, su
h as a square wave, interpolation adds a spurious

overshoot to the waveform.

(a) Interpolation O� (b) Interpolation On

Figure 8: Interpolation

1

In pra
ti
e, the lowpass 
uto� frequen
y is set to somewhat less than half the sampling frequen
y to allow for the �nite

rollo� rate of the �lter.
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6 Waveform Generator

Figure 9: Generator Controls

The waveform generator 
ontrols are shown in �gure

9.

The Amplitude 
ontrol is 
alibrated from 0 to

100%.

6.1 Setting Frequen
y

The frequen
y 
ontrol adjusts frequen
y between the

limits shown in the two buttons at the top and bot-

tom of the frequen
y slider. In the default, these

limits are 0.1Hz to 10MHz. The frequen
y resolu-

tion is 0.1Hz. The a

ura
y is based on a 
rystal


lo
k. A readout shows the 
urrent frequen
y to a

resolution and a

ura
y of 0.1Hz.

You 
an set the frequen
y by moving (left mouse

button down and drag) the slider. Alternatively,

left-
li
k on the frequen
y display and enter a fre-

quen
y value in the pop-up dialog. You 
an also


li
k in the trough of the frequen
y slider to in
re-

ment or de
rement the 
urrent setting.

6.2 Setting Sweep Limits

To 
hange one of these slider limits, left-
li
k on it.

An entry widget appears, prompting for a new maxi-

mum or minimum frequen
y. Enter a new value and

left-
li
k on OK or hit <
arriage-return>. The

new value appears above or below the frequen
y

slider.

For example, if you are sweeping an audio devi
e,

you 
an set the maximum and minimum frequen
ies

to 20,000 and 20Hz. Then the full s
ale movement of the slider applies to that range.

As another example if you are investigating the frequen
y response of a 3kHz narrow-band a
tive �lter,

you 
ould set the frequen
y range to 3050Hz maximum and 2950Hz minimum. Then the adjustment

range of the generator is 100Hz, giving e�e
tive �ne-grain 
ontrol of frequen
y.

6.3 Sweep Mode

The 
ontrol 
hara
teristi
 of the frequen
y slider 
an be set to Logarithmi
 or Linear. The Logarithmi



ontrol in
reases the frequen
y in an exponential fashion as it is in
reased, whi
h is the most 
onvenient


hara
teristi
 is most situations. In Logarithmi
 Mode, the physi
al mid-point of the s
ale 
orresponds

to about 700Hz.

In Linear Mode, the 
ontrol 
hara
teristi
 is linear and the mid-point of the 
ontrol is 1.5MHz. In

e�e
t, this assigns most of the physi
al movement to high frequen
ies.

6.4 Manual and Automati
 Sweep

The Cir
uitGear GUI provides frequen
y 
ontrol of the generator with a manual frequen
y 
ontrol.

Automati
 sweep is provided with a separate feature: the VNA (Ve
tor Network Analyser), aka Bode

Plotter software, whi
h operates the generator to make a sweep and the os
illos
ope to plot the response

of some devi
e or network. See se
tion 9 on page 22.
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6.5 Waveform Amplitude

The waveform 
an be adjusted between 0 and 2.5 volts peak. Combinations of amplitude and o�set that

ex
eed +/-2.5 volts will 
ause the waveform to 
lip. You 
an also left 
li
k in the trough of the slider to

make small adjustments to the amplitude.

6.6 Waveform O�set

The CGM-101 in
ludes a waveform o�set 
apability of +/-2.5 volts. Combinations of amplitude and

o�set that ex
eed +/-2.5 volts will 
ause the waveform to 
lip. For example, it is possible to 
reate an

un
lipped waveform of +/-1 volt with +1.5 volts of o�set, but not 2 volts of o�set. Adjust the waveform

o�set by dragging the o�set slider. You 
an also left 
li
k in the trough of the slider to make small

adjustments to the o�set.

6.7 Waveform Sele
tion

There are four built-in waveforms: sine, square, triangle and sawtooth. Sele
t the desired waveform by

left-
li
king on the 
orresponding waveform sele
tion button.

Sele
tion of a waveform 
auses that waveform data to be downloaded from the host PC into the

Cir
uitGear hardware. Ea
h waveform data �le 
onsists of 2048 data points. Ea
h data point has a

value between 0 and 255. The waveforms for Sine, Square, Triangle Sawtooth and Noise are programmed

into the �rmware of the devi
e.

You 
an load a 
ustom waveform. Sele
ting the Load Custom waveform pops up a �le sele
tion box

so you 
an sele
t any waveform. (See se
tion 6.8 below on 
reating a 
ustom waveform.) Figure 3 on

page 9 shows the os
illos
ope tra
e of a 
ustom waveform produ
ed by the generator.

There is a 1 to 2 se
ond download delay after sele
ting a waveform before the generator begins

produ
ing the waveform. During that time, other waveform sele
tion buttons are lo
ked out to prevent

button mashing.

Having loaded a 
ustom waveform, you 
an save it to the CGM-101 hardware memory, by 
li
king

on the Save Custom button. Thereafter, 
li
king on Stored Custom will sele
t that waveform. (Using

Stored Custom avoids having to use the �le sele
tor widget to sele
t a 
ustom waveform, so it's a

short
ut to sele
t a 
ommonly-used 
ustom waveform.)

6.8 Waveform Format

Waveform data �les are stored in the same dire
tory with the sour
e 
ode. On a Windows ma
hine, the

path to this dire
tory would be something like:

C:\Program Files\Sys
omp\CGM101-1.19\Sour
e.

By 
onvention, waveform �les end in a .dat su�x, for example, sawtooth.dat. Other su�xes are

permitted. These are plain vanilla text �les, so they 
an be loaded into a text editor su
h as Notepad.

Ea
h �le 
onsists of 2048 entries (X values). Ea
h of these 2048 entries is the value of the waveform

at that point (Y value), ranging from 0 (most positive) to 255 (most negative). Ea
h entry value is

terminated by a 
arriage-return, line-feed pair.

A waveform data �le 
an be 
onstru
ted manually, using a programming language (eg, Visual Basi
)

or from a spreadsheet (eg, Open O�
e 
al
).

Amplitude 
an be set by the Cir
uitGear generator hardware, so it is best to s
ale the amplitude

between 0 and 255. The CGM-101 in
ludes o�set hardware, so waveform o�set need not be in
luded in

the waveform des
ription.

If the waveform 
an be des
ribed by an equation, you 
an use a spreadsheet to generate the 
orre-

sponding waveform values. Save the 
olumn of waveform �le values as a .
sv (
omma-separated values)

�le. Then examine the �le using a text editor (su
h as Notepad) to ensure that there are no extraneous


hara
ters and the �le is formatted 
orre
tly. Then on the graphi
al user interfa
e for the CGM-101,

load the �le into the generator by sele
ting the Load Custom waveform.
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7 Digital Input-Output Se
tion

Figure 10: Digital Controls

The Cir
uitGear digital 
ontrols are shown in �gure 10. These input and output lines 
an be operated

from the GUI 
ontrols in �gure 10 or they may be 
ontrolled by software that 
ommuni
ates with the

Cir
uitGear API (appli
ations program interfa
e, se
tion 13 on page 30).

On a netbook 
omputer, the digital 
ontrols run o� the bottom of the s
reen. The digital I/O 
ontrols

are in their own window, and 
an be moved somewhere 
onvenient or minimized.

7.1 8 Bit Digital Output

Cli
king on an individual Digital Output button bit 
auses the 
orresponding bit to illuminate on the

GUI and the 
orresponding output line to go into the high HIGH state. Cli
king again 
auses the bit to

extinguish and the 
orresponding output line to go LOW.

The available 
urrent to a USB devi
e is 500mA maximum, and this 
urrent must operate the

os
illos
ope and signal generator as well as the digital 
ir
uitry. Consequently the digital drive 
urrent

is very limited: a few milliamps per output. Load devi
es su
h as high-
urrent LEDs or DC motors will

require their own power supply.

7.2 8 Bit Digital Input

The GUI digital input indi
ators illuminate when the 
orresponding input level is a logi
 HIGH. The logi


levels may 
orrespond to 3V HC logi
 or 5V HC logi
. Great 
are should be taken not to ex
eed 5 volts

on any input. Inputs are bu�ered but all devi
es are surfa
e-mount soldered, so they are not trivial to

repla
e.

7.3 PWM: Pulse Width Modulated Waveform

The PWM output (available on the rear panel 
onne
tor) is a 5 volt pulse. The duty 
y
le is 
ontinuously

adjustable with the Duty Cy
le slider, over a range of 0% to 100%. The output frequen
y is set by the

Frequen
y slider, over a range of 1Hz to 1MHz.

The output drive 
urrent should be limited to a few milliamperes of 
urrent.

7.4 External Trigger

When the Trigger Mode 
ontrol on the GUI is set to External, a positive-going transition on this pin

rear panel pin 
auses the s
ope to trigger. To test external trigger:

1. Set the trigger mode to 'auto'.

2. Conne
t the output of the generator to 
hannel A of the s
ope and adjust the generator amplitude

so the s
ope shows a sine wave.
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3. On the rear panel, use a jumper 
able to 
onne
t the Ext Trig pin to the Digital output 0

pin.

4. Under Trigger Mode sele
t External.

5. From the GUI, use the mouse to 
li
k on Digital Output 0.

6. On the 0V to 5V transition on digital output 0, the s
ope should briefly display 'triggered'

and a new sample of the waveform should display. On the 5V to 0V transition, triggering

will not o

ur.

Edge polarity is not sele
table on external triggering, the trigger edge is always positive going.

The trigger input is prote
ted against overvoltages but we do not re
ommend relying on that. We

re
ommend keeping the trigger signal between 0 and +5volts.

8 Spe
trum Analyser

A 
omplex waveform may be treated as being 
omposed of a number of sinusoid waveforms. These

sinusoids are of various phases, frequen
ies and amplitudes. The des
ription of the magnitude, phase

and frequen
y of these various waves is known as the spe
trum of the signal, by analogy with the spe
trum

of light.

Spe
trum Analysis or Fourier Analysis is the pro
ess of analysing some time-domain waveform to

�nd its spe
trum. We also say that the time domain waveform is 
onverted into a frequen
y spe
trum

by means of the Fourier transform.

Cli
king on Tools -> Spe
trum Analysis brings up the spe
trum analysis display of �gure 11. The

displayed spe
trum in this image is a 10kHz square wave.

The theory of Fourier Analysis shows that a square wave is 
omposed of a fundamental of magnitude

E volts at frequen
y f (10kHz in this 
ase) with the following harmoni
s: E/3 magnitude at frequen
y

3f , E/5 magnitude at frequen
y 5f , E/7 magnitude at frequen
y 7f , and so on. The spe
trum display

shows this pattern.

Ea
h verti
al line represents one of these frequen
y 
omponents. The height of the line is proportional

to the magnitude of that parti
ular 
omponent. The horizontal axis is a linear s
ale of frequen
y, with

zero frequen
y (DC) at the left edge.

The verti
al 
ursor 
an be dragged horizontally to determine the frequen
y and magnitude of a


omponent of the spe
trum.

The spe
trum display and main waveform display are a
tive at the same time, allowing one to

simultaneously observe a waveform in the time domain and frequen
y domain.

8.1 Interpreting the Spe
trum Analyser Display

Be
ause of fundamental limitations in a sampled-data system, it is possible for the display to be mis-

leading. Here are some important points to keep in mind when using spe
trum analysis based on digital

methods:

• Adjust the os
illos
ope timebase 
ontrol to show many 
y
les of the waveform. Then swit
h to the

Spe
trum display. This will result in a wide range of frequen
ies on the x axis.

• The Effe
tive Sampling Rate is shown in a readout at the bottom right 
orner of the spe
trum

display. This is important: the sampling rate must be at least twi
e the frequen
ies being analysed

to avoid aliasing. Put another way, there must not be frequen
y 
omponents above the Nyquist

rate, whi
h is half the sampling rate. In the example shown in �gure 11, the sample rate is 20kHz.

The frequen
y 
omponents range from 1kHz to 9kHz, below the Nyquist rate of 10kHz

2

.

2

Harmoni
s of the square wave extend to mu
h higher frequen
ies but we assume their amplitude is small enough to be

ignored.
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Figure 11: Square Wave Spe
trum

• A sweeping type analog spe
trum analyser moves a bandpass �lter a
ross a range of frequen
ies

to determine the spe
trum. A digital spe
trum analyser su
h as this one divides up the frequen
y

range into a number of bins and then measures the energy in those bins.

The main os
illos
ope display of the CGR-101 is 500 points. This is padded to 512 points

3

by

appending zeros to the waveform re
ord. As a result, there are 256 frequen
y bins when using the

main os
illos
ope display.

The 
entre frequen
y of ea
h of these bins may not 
oin
ide exa
tly with the frequen
y 
omponents

present. If that is the 
ase, then the displayed amplitude will be in
orre
t and should only be

regarded as an approximation of the true situation.

• As the readout 
ursor is dragged higher in frequen
y it jumps from bin to bin, reading out the


entre frequen
y of ea
h bin. A given frequen
y 
omponent may not be 
entred in its bin, so the

3

The FFT routine requires that the number of points be a power of 2.
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frequen
y readout will be only approximate. For example, in �gure 11, the square wave frequen
y

(generated by a Sys
ompWGM-101 waveform generator) is at a frequen
y 1kHz to within a fra
tion

of a Hz. The 9th harmoni
 is at 9kHz. The spe
trum display readout puts the 9th harmoni
 at

9.0234 Hz, whi
h is approximately 
orre
t.

8.2 Frequen
y S
ale, Bin Spa
ing

It is sometimes useful to be able to determine the resolution of the frequen
y axis. Ea
h frequen
y bin

has a width ∆f = 1/T Hz where T is the length of the data re
ord in se
onds. If there are N points

in the data re
ord, then N/2 points are displayed as positive frequen
y. (The other N/2 points are

redundant.)

Example

Determine the frequen
y resolution (bin spa
ing) for the 
ase of the display of �gure 11.

Solution

The sample rate is 200kS/se
. The sample interval ∆T is the re
ipro
al of this:

∆T =
1

200× 103

= 5 µSe


The number of points N in the data re
ord is 512 points, so the total length of the data re
ord is:

T = N∆T

= 2.56 mSe


The resolution ∆f is the re
ipro
al of the re
ord length:

∆F =
1

T
= 390.625 Hz

For example, the 7th harmoni
 should appear at f7 = 70kHz. The spe
trum display a
tually puts it

at 70313 Hz, whi
h is bin 180.

F7 = 180× 390.625

= 70313 Hz

The maximum frequen
y fmax on the display o

urs at bin 256:

fmax = 256× 390.625

= 100 kHz

8.3 Spe
trum Display Cursor Control

For �ne 
ontrol over the spe
trum frequen
y readout. the left and right 
ursor buttons on the keyboard

move the spe
trum display 
ursor one pixel to the left or right.
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8.4 Spe
trum Weighting Fun
tions

Weighting or window fun
tions are often applied to the time-sequen
e data prior to transformation

into the frequen
y domain. All window fun
tions taper the data down to zero at its ends. Then the

dis
ontinuity 
aused by a �nite re
ord length does not a�e
t the shape of the transform.

The 
hoi
e of window fun
tion depends on the appli
ation, and all window fun
tions are a 
ompromise

of some sort. For example, some window fun
tions provide very a

urate amplitude readings, others are

best for separating 
losely spa
ed frequen
ies. A 
olle
tion of window fun
tions is shown at

http://en.wikipedia.org/wiki/Window_fun
tion.

The 
urrent spe
trum analyser in
ludes the re
tangular window. This window does not shape the

time fun
tion, all points on the time re
ord are weighted equally. The Hamming, Hann and Triangular

weighting fun
tions are also available.

8.5 Appli
ations

Spe
trum analysis has a number of appli
ations in ele
troni
s and me
hani
al engineering:

• A pure tone has no harmoni
s and will show up on a spe
trum display as one single verti
al

line. Distortion of a sine wave will 
reate additional harmoni
s. Consequently, a measure of the

magnitude of the harmoni
s is a measure of the magnitude of the harmoni
 distortion.

• In a distortion-free (linear) system, two separate input tones (single frequen
ies) will emerge as

the same two tones at the output. If the system is distorting (non-linear), then the system will

generate other tones at the sum and di�eren
e frequen
ies of the input signals. A measure of these

extra signals is a measure of the intermodulation distortion.

• The existen
e of 
ertain frequen
ies in a signal may give some 
lues as to its sour
e. For example,

if a signal 
ontains the power line frequen
y (eg, 60Hz in North Ameri
a, 50Hz for the UK), then

it is probably pi
king up interferen
e from the AC power line.

• Power systems frequently manipulate waveforms by 
hopping them or 
ombining them with other

signals. Spe
trum analysis allows one to measure the harmoni
 
ontent of a signal, whi
h may be

spe
i�ed as a requirement.

• The analysis of a me
hani
al system for resonan
es 
an be done by driving the system with a wide-

band ex
itation signal, an impulse hammer blow or random noise from a shaker. Mi
rophones or

a

elerometers 
onvert the me
hani
al vibration of the system to an ele
tri
al signal. The spe
trum

analysis of this signal indi
ates the me
hani
al resonan
es in the stru
ture.

• The extra
tion of signals from noise may require some knowledge of the spe
trum of the signal and

the noise.

• It is useful to see the spe
trum diagram for modulation and other signal manipulations.

Further information on spe
trum analysis is in the paper Introdu
tion to Digital Spe
trum Analysis,

whi
h is on the Sys
omp web site.
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9 Ve
tor Network Analyser
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Figure 12: Network Analyser Wiring

An ele
tri
al network, su
h as a lowpass �lter, is


hara
terized by its amplitude and phase response.

The amplitude response is a plot against frequen
y

of the gain of the network: the ratio of output signal

amplitude to input signal amplitude. The phase re-

sponse is a plot of the phase of the network: the dif-

feren
e between the output phase and input phase.

The test signal is a sine wave that is swept over a

range of frequen
ies, taking 
are not to overload the

network.

Figure 13: Ve
tor Network Analyser

As part of their AC Cir
uits lab, ele
tri
al engineering students are required to plot these response


urves by hand. This is a very tedious pro
ess. Ea
h point in the plot requires setting the generator

frequen
y, reading the input signal amplitude, reading the output signal amplitude, reading the output

signal phase, and plotting the result. The CGR-101 ve
tor network analyser does this automati
ally over

a range of 1Hz to 1MHz, or some part thereof. This makes it pra
ti
al to explore the e�e
t of 
hanging


omponent values. For example, if the resistor or 
apa
itor value in an RC lowpass �lter is 
hanged, one


an immediately determine the e�e
t on frequen
y and phase response.

The CGR-101 has two prin
ipal modes: as an os
illos
ope and signal generator (with digital input-

output), and as a network analyser. To 
hange between them, sele
t:

Hardware -> Network Analyser Mode, or

Hardware -> Cir
uit Gear Mode.

Figure 13 shows a s
reen shot of a VNA plot of a small transformer. Noti
e how the frequen
y

response rolls o� at low frequen
ies and shows a resonant peak at high frequen
ies.

Figure 12 shows how an RC low-pass �lter 
ir
uit would be 
onne
ted. Noti
e that there is no
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internal 
onne
tion between the generator output and the 
hannel A input. The instrument grounds are


onne
ted internally, so only one ground wire is required to the external 
ir
uit.

To measure the impedan
e of some other two terminal devi
e su
h as an indu
tor or loudspeaker,


onne
t it in pla
e of the 
apa
itor in �gure 12. Choose the resistor to be larger than the maximum

impedan
e of that 
omponent. Then, in e�e
t, the devi
e is driven by a 
onstant 
urrent and the voltage

a
ross the devi
e is proportional to its impedan
e.

The display of �gure 13 is the amplitude and phase response of a small 1:1 audio transformer. The

primary was driven by the generator and 
onne
ted to Channel A. The se
ondary was 
onne
ted to

Channel B.

Noti
e that the amplitude response rolls o� below 20Hz and exhibits very substantial peaking around

300kHz. (This shows up as ringing in the square wave time-domain response.) The transformer midband

phase response be
ause the transformer primary and se
ondary are deliberately wired out of phase. The

jump in the phase response from −180◦ to +180◦ is 
orre
t: plus or minus 180 degrees is the same

physi
al result.

• Two slide 
ontrols set the start and �nish frequen
y

• A third slider sets the frequen
y step. The frequen
y step is the amount by whi
h a frequen
y is to

in
rease to 
reate ea
h new measurement frequen
y. Or, put another way, it's the ratio between

two adja
ent measurement frequen
ies. The frequen
y step multiplies by a fa
tor (rather than

adding a 
onstant fa
tor) be
ause the frequen
y s
ale is logarithmi
.

The network analyser frequen
y labels 
an be viewed in �xed-point or s
ienti�
 notation. This is

sele
table under the View menu.

• A fourth slider sets the signal amplitude.

• The Os
illos
ope Display window shows the input and output waveforms, whi
h should be sine

waves. If the signals show 
lipping, redu
e the signal amplitude.

• The Start button initiates a frequen
y sweep. Sweeping is slow at low frequen
ies and speeds up

as the frequen
y in
reases.

• The display autos
ales, that is, tries to sele
t a s
ale that just �lls the display.

• The amplitude dynami
 range of the VNA is in ex
ess of 50db. The VNA automati
ally adjusts

the input signal attenuators of the os
illos
ope se
tion to obtain the best possible signal-noise

ratio without 
lipping. It also uses the full 10 bit range of the os
illos
ope A/D 
onverters. In

the frequen
y response plot of �gure 13, the amplitude and phase plots be
ome errati
 at high

frequen
ies. This o

urs be
ause the output signal from the low pass �lter is extremely small in

that region.

• The amplitude and phase information may be saved to a .
sv format data �le (whi
h 
an be loaded

into Matlab or a spreadsheet). With the VNA operational, sele
t Tools -> Export Waveform (CSV).

9.1 Phase Display

When the phase is 
lose to the top or the bottom of the display, small phase 
hanges 
an 
ause it to

jitter in an annoying fashion from one limit to the other. For a signal that 
hanges over a wide range of

phase, this 
annot be entirely prevented. However, it 
an be redu
ed by adjusting the verti
al s
ale of

the phase display.

By default, the phase display ranges from +180◦ to −180◦, with 0◦ in the 
entre. To 
hange this,

pla
e the 
ursor in the phase plotting area and right 
li
k. A menu appears allowing the sele
tion of a

di�erent phase display arrangement: +360◦ to 0◦, for example.
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9.2 Linear and Narrow Band Sweep

It is possible to set the analysis to a narrow range of frequen
ies to 
hara
terize narrow-band �lters and

piezoele
tri
 
rystals.

• Cli
k on the numeri
 readout for Start Frequen
y. An entry window appears. Enter the starting

frequen
y, in Hz.

• Cli
k on the numeri
 readout for End Frequen
y. An entry window appears. Enter the ending

frequen
y, in Hz.

• Cli
k on the numeri
 readout for Frequen
y Step. An entry window appears. Enter the amount

by whi
h the frequen
y in
reases for ea
h measurement. (This value must be greater than the

minimum frequen
y step for the waveform generator, whi
h is 0.1Hz.)

• Both Logarithmi
 and Linear sweep will work, but the Linear Sweep setting allows more pre
ise


ontrol of the display range. Sele
t Linear Sweep to pre
isely set the display frequen
y span to

the previously entered Start and End frequen
ies.

• Sele
t the maximum amplitude range.

• Press Start and the analysis will pro
eed.

If the sweep range is substantially outside the passband of the �lter, the VNA may 
omplain about

insu�
ient signal. In that 
ase, 
hange the sweep range to start and end on the skirts of the �lter.

9.3 VNA Theory

More information on the theory of the ve
tor network analyser is in the Sys
omp Appli
ation Note A

Software-Based Network Analyser at http://www.sys
ompdesign.
om/na-theory.pdf.

10 Rear Panel Conne
tor

The rear panel 
onne
tor provides a

ess to the following signals:

• Digital outputs 0 through 7

• Digital inputs 0 through 7

• External trigger output

• PWM (Pulse Width Modulated) output

• External trigger input

• Ground

The pinout is shown on the 
ase label of the instrument and in �gure 14 below. These fun
tions are

des
ribed in se
tion 7 above.

10.1 Rear Panel Conne
tor Mating Plug

One suitable rear panel 
onne
tor mating plug is as follows:

MODE part # 35-0202-0

20 position, 2 row, 0.1" (2.54mm) 
onta
t spa
ing.

Mates with 20 way 0.050" spa
ing flat 
able.

Polarizing key (Centre bump)

Strain Relief

A
tive-Te
h pri
e: \$0.38
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Cir
uitGear Rear Panel Conne
tor

View toward rear panel
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GND Trigger Out

Digital Outputs

Digital Inputs

Ext Trig In PWM Out

Figure 14: CGM Mini Rear Panel Conne
tor Pinout

Available from MODE Ele
troni
s, http://www.mode-ele
.
om

Distributed by A
tive-Te
h Ele
troni
s in Canada, http://www.a
tive123.
om

Another suitable 
onne
tor is this one:

3M part # D89120-0131HK

Digikey part # MKC20E-ND

20 position, 2 row, 0.1" (2.54mm) 
onta
t spa
ing.

Mates with 20 way 0.050" spa
ing flat 
able.

Polarizing key (Centre bump)

Conta
ts 10u gold plate

Digikey pri
e: \$0.69

Mating strain relief for this 
onne
tor:

3M part # D3448-89120

Digikey part # MESR20-ND

Available from Digikey, http://www.digikey.
om

Any �at 
able with 0.050" 
ondu
tor spa
ing that will mate with IDC (Insulation displa
ement


onne
tor) should be suitable for use with these plugs. For example:

3M 3302 Series

Digikey part # MCM-20M-5-ND (5 foot length)

10 
olour repeat, 
lear 
arrier

Digikey pri
e: $7.50

The installation of an IDC 
onne
tor onto �at 
able is des
ribed here:

http://hubbard.engr.s
u.edu/embedded/guide/ribbon/

So
ket-Pin or So
ket-So
ket Lead

Another 
onne
tion devi
e that is very handy is the so
ket-pin lead. This 
onsists of short length of

wire with a so
ket at one end and a pin at the other. The so
ket �ts exa
tly onto one of the pins of the

Mini rear panel 
onne
tor. The pin plugs ni
ely into a protoboard.

A similar lead has so
kets at both ends of the wire: one end 
an 
onne
t to a Mini rear panel


onne
tor pin, and the other to a header pin on a PC board.

Both types of leads are available from Creatron in Toronto: http://www.
reatronin
.
om/.
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11 Safe Measurement Te
hnique

These notes are in
luded for the bene�t of those who are new to using an os
illos
ope. The information

is not unique to this os
illos
ope, but applies to most os
illos
ope measurement instruments.

Rather than simply state rules and prohibitions, we explain why 
ertain pro
edures are dangerous

and why some te
hniques should be avoided. This information is provided for guidan
e in using the

os
illos
ope and is not intended to repla
e proper training in working around high voltage 
ir
uits.

In general, this os
illos
ope may be used safely to observe signals in low-voltage 
ir
uits where the

power supply is �oating from the AC line.

11.1 Floating Power Supply

Oscilloscope
and
ComputerPower Line Ground

+
Red

−
Black

Ground
Green

Power Supply

Input

Ground

Figure 15: Floating Power Supply

In this 
ontext, �oating power supply is one in whi
h neither terminal is 
onne
ted to the power line

ground.

Consider the 
ir
uit shown in �gure 15. Like many lab power supplies, the power supply has three

terminals: positive, negative and ground. The ground terminal is 
onne
ted to the third prong on the

line 
ord, whi
h 
onne
ts to the power line ground wire.

The os
illos
ope has two 
onne
tions: the input terminal and ground terminal. On the front panel

BNC 
onne
tor, the inner 
onta
t is the input, the outer ring is ground. The ground 
onne
tor �nds its

way to the AC ground line via the third prong on its line 
ord.

As shown in �gure 15, either lead on the os
illos
ope 
an be safely 
onne
ted to the positive or

negative terminal of the power supply. With proper 
are to avoid short-
ir
uits of the power supply, this

is a safe measurement situation.

11.2 Grounded Power Supply

Now 
onsider that the negative terminal of the power supply is 
onne
ted to its Ground terminal, as

shown in �gure 16.

If the ground terminal of the os
illos
ope is 
onne
ted to the ground terminal of the power supply,

then the 
ir
uit is in no danger and will work properly. However, if the ground terminal of the

os
illos
ope is inadvertently 
onne
ted to the positive terminal of the power supply, then

the power supply will be 
onne
ted to a short 
ir
uit. The power supply short 
ir
uit will

drive 
urrent around the ground 
onne
tions of the power supply and os
illos
ope. Sin
e lab

power supplies are usually 
urrent limited to less than an ampere of 
urrent, the equipment will likely
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+
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Power Supply
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Ground
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Input

Ground

Figure 16: Floating Power Supply

survive. However, the 
ir
uit will not fun
tion properly be
ause the power supply is in a short-
ir
uited


ondition.

To avoid this situation, do not 
onne
t the positive or negative terminal of the lab power

supply to the ground terminal. Leave the supply �oating.

11.3 Battery and AC Adaptor Power Supplies

If batteries are used to power the 
ir
uit under test, the problemati
 situation of se
tion 11.2 is not likely

to o

ur, be
ause batteries do not normally have a ground 
onne
tion to the AC line

4

.

An AC Adaptor is essentially a small transformer 
oupled DC power supply. These are usually

supplied with a two-prong line 
ord, so there is no ground 
onne
tion to the AC power line ground. The

supply is �oating so the problem of se
tion 11.2 
annot o

ur.

11.4 Russian Roulette and AC Line Voltage

The unsafe situation of an os
illos
ope being used to measure AC line voltage, is shown in �gure 17.

The AC line 
onsists of three 
onne
tions: the hot line, the neutral line, and the ground wire. For

safety reasons, the neutral and ground are 
onne
ted together and to an earth ground at the system AC

distribution panel. The hot and neutral line 
arry load 
urrent in the system � normally the ground

wire does not 
arry any 
urrent. Be
ause the neutral is 
arrying 
urrent and be
ause the neutral wire

has resistan
e, at any given point in the system there likely will be a small voltage di�eren
e between

the neutral and ground wires.

If the ground wire of the os
illos
ope is inadvertently 
onne
ted to the hot wire of the AC line,

an extremely large short 
ir
uit 
urrent will �ow through the ground 
onne
tion. Eventually, a 
ir
uit

breaker will open, a fuse will blow, or the short-
ir
uit 
urrent will destroy a 
ondu
tor. However, until

that o

urs, the short 
ir
uit 
urrent 
an be in the order of hundreds of amperes. This 
urrent will

destroy the os
illos
ope and 
omputer, and the resultant �aming debris may 
ause injury to nearby

living organisms, in
luding humans. It may also start a �re.

Furthermore, 
onne
ting the ground lead of the os
illos
ope to the AC neutral line 
auses another

problem - it e�e
tively 
onne
ts the neutral and ground AC lines at that point. Now the neutral 
urrent

has another path, and some of it will �ow through the os
illos
ope and 
omputer ground leads. If this


urrent is su�
ient, it may damage the os
illos
ope and 
omputer.

4

The disadvantages of batteries are (a) they run down and (b) they are not 
urrent limited. A short 
ir
uited battery


an do signi�
ant damage.
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Ground Neutral Hot

To earth
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Figure 17: AC Line Voltage

Noti
e that this same situation 
an o

ur with equipment that is not transformer isolated from the AC

line. For example, some ele
troni
 equipment has a dire
t 
onne
tion to the AC line, so that the 
hassis

is 
onne
ted dire
tly to the neutral line of the AC system. To safely observe the signals in this devi
e

with an os
illos
ope the equipment must be isolated from the AC line by a transformer. The transformer

must fun
tion as an isolation transformer, the se
ondary winding must not have an ele
tri
al 
onne
tion

to either of the primary leads, and the transformer must 
onsist of a separate primary and se
ondary

winding.

An autotransformer (
ommon trade name Varia
) is an adjustable transformer that is often used

for adjusting line voltage. An auto transformer does not have an independent se
ondary winding and


annot be used to isolate ele
troni
 equipment from the AC line.

11.5 Removing the Ground

The potential for a short 
ir
uit is redu
ed if the ground 
onne
tion is removed from the 
omputer.

However, this is extremely dangerous be
ause metalli
 
onne
tions on the 
omputer (su
h as the shell

around a 
onne
tor) are 
onne
ted to the ground line. A 
onne
tion to the AC line puts those metalli


points at line potential, presenting a serious sho
k hazard to the user and possible short 
ir
uit if atta
hed

equipment is grounded.

The AC ground 
onne
tion (the 'third prong' on a plug) is there spe
i�
ally to prevent the 
hassis of

the equipment from assuming a potential that is above ground, and therefore dangerous to a human op-

erator. Removing that ground 
onne
tion removes any grounding prote
tion. This is a serious violation

of health and safety regulations.

Similarily, a battery-powered laptop 
omputer, when dis
onne
ted from its line-operated 
harger,

is not 
onne
ted to the ground line of the AC power system, so it is less likely to 
ause the kind of

short 
ir
uit des
ribed in the previous se
tion. However, it is extremely dangerous to rely on this. The

laptop may itself be
ome live at the AC line potential, whi
h makes it hazardous to the operator and

any atta
hed equipment (su
h as a line-operated video monitor).

11.6 Observation of AC Line Voltages

If you must observe line voltage, here are the rules:
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• The os
illos
ope must be able to 
ope with the peak value of the input AC voltage. The Sys
omp

DS-101 is 
erti�ed to reliably a

ept up to 50 volts on its input terminal.

A times-ten os
illos
ope probe in
reases this by a fa
tor of ten. It is absolutely essential to use a

probe that 
an withstand this voltage, and it essential to ensure that the probe 
annot inadvertently

be swit
hed to a times-one setting.

Noti
e that the peak value of a sinusoidal voltage is 1.41 times the RMS value. So a 117VAC line

voltage will peak at around 170 volts.

• There must be no dire
t 
onne
tion to the AC line. If the equipment is line operated, then it must

be powered by an isolation transformer (see above).

• It is possible to obtain ele
troni
 probes that provide an isolation barrier between the line 
ir
uit

and the os
illos
ope. For example, the measurement signal is transferred from the AC line side

to the os
illos
ope side by means of an opti
ally 
oupled 
ir
uit. There is no ele
tri
al 
onne
tion

between the os
illos
ope and the AC line. The signal is transferred over a beam of light. This

method removes all possibility of short-
ir
uiting the line voltage to ground. See for example

http://www.powertekuk.
om/.

12 Adjustments

The os
illos
ope has been adjusted before shipping, so it should not need adjustment before use. These

instru
tions are provide for referen
e purposes.

12.1 Input Compensation Capa
itors

The s
hemati
 of the input 
ir
uitry of the os
illos
ope verti
al preampli�er is shown in �gure 18.
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Figure 18: S
ope Input Compensation Network

The two 
hannels are identi
al.

Stray 
apa
itan
e at the output of the voltage divider has the potential for limiting the bandwidth.

To make the divider frequen
y independent, the resistive divider R1, R2 is a

ompanied by a 
apa
itive

voltage divider VC1, C1. The 
apa
itive divider must be adjusted to have the same division ratio as the

resistors. This is a

omplished by adjusting VC1.

To do so, remove the 
ir
uit-board from its plasti
 
ase. Conne
t it to the 
omputer via its USB


able and start the host software. Apply a square wave input signal to one of the s
ope 
hannels. Adjust

the magnitude of the square wave su
h that it makes a suitable display. Adjust the os
illos
ope timebase

su
h that the leading edge of the square wave is visible.

The two variable 
apa
itors are relatively large, square 
omponents that rise above the other 
om-

ponents on the board. (The 
urrent versions have orange 
asings.) On the 
urrent design they are

designated C61 for Channel A and C81 for Channel B. Lo
ate the variable 
apa
itor on the 
ir
uit that


orresponds to the input 
hannel with the signal. With a tiny s
rewdriver, adjust that variable 
apa
itor
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until the square wave shows the fastest possible rise time without overshoot. It is best to use a s
rew-

driver with an insulated shaft be
ause a non-insulated s
rewdriver will 
onne
t human body 
apa
itan
e

into the 
ir
uit whi
h a�e
ts its operation. If the s
rewdriver is not insulated, make an adjustment and

then remove the s
rewdriver to see the e�e
t.

Repeat the same pro
edure with the se
ond os
illos
ope 
hannel.

Reassemble the unit ba
k in its 
ase.

If you are using a x10 os
illos
ope probe, the input 
apa
itan
e of the s
ope 
hannels will have


hanged slightly. You will need to adjust a x10 probe for best square wave response.

If the probe is a x1 x10 swit
hable unit, ensure that the probe is swit
hed to the x10 position. Atta
h

it to one of the 
hannels. Conne
t the probe to a square wave sour
e, su
h as the CGM-101 generator

output. Find the 
ompensation adjustment s
rew on the s
ope probe. In the e
onomy probes we sell,

the s
rew adjust is red and lo
ated in the base of the probe 
able, near the BNC 
onne
tor. In the

professional probe we sell, the s
rew adjust is yellow and lo
ated in the probe, near the handle. Adjust

this s
rew for best square wave response.

13 Instrument Commands

These 
ommands are low-level instru
tions to the s
ope hardware. The 
ommands (and where relevant,

messages ba
k from the hardware) are ASCII strings so that they 
an be generated easily by software

or a human operator.

There are two situations where the interfa
e 
ommands may be useful.

• The s
ope hardwaremay be operated dire
tly from a terminal emulator program su
h as Hyperterminal

under Windows, Mini
om or Seyon under Linux.

• Knowing the 
ommands allows one to 
reate a s
ope 
ontrol program with di�erent fun
tionality.

For example, a program 
ould be 
reated to read the os
illos
ope and plot the results on a strip-


hart type of display.

Should undertake su
h a proje
t, the T
l sour
e 
ode for the Os
illos
ope GUI, whi
h is in
luded

in the install �les, will be a useful sour
e of ideas in 
ontrolling the s
ope.

There is no requirement that the 
ontrolling program be written in the T
l language. Any program

that 
an issue ASCII strings to a serial port will be 
apable of 
ontrolling the s
ople hardware (eg

Matlab, Visual Basi
).

13.1 Using the Debug Console

When you send a 
ommand to the s
ope, it does not e
ho any 
on�rmation ba
k to the host terminal.

This is be
ause you are doing with the terminal exa
tly what is done with a 
ontrol program, and

responses from the s
ope would slow down the overall operation of the system.

Ea
h 
ommand 
onsists of an as
ii string of 
hara
ters, su
h as T55<
r> to set the trigger level to

55, where <
r> is a 
arriage return 
hara
ter.

If you are running under a Windows operating system, in addition to the material in the user manual,

you 
an see 
ommands being sent to the os
illos
ope by sele
ting

View -> Debug Console.

This brings up a terminal s
reen whi
h lists 
ommands as they are being sent to the s
ope hardware,

and some other debug information.

If the operator starts the program from a terminal window, exe
uting a 
ommand like wish main.t
l,

then the terminal window be
omes the 
onsole.

This information s
rolls past rather qui
kly when the s
ope is in auto trigger mode, be
ause it is

repeatedly obtaining data from the hardware. To slow this down, put the s
ope in 'Manual Trigger'

mode. Now ea
h time you hit the 'manual trigger' button, the debug s
reen will show the 
ommands

that were sent to the s
ope hardware.
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Now you 
an 
hange 
ontrol settings on the s
ope GUI and see the 
orresponding 
ommands as they

are sent to the s
ope hardware. For example, move the trigger level 
ursor on the s
ope s
reen and you

will see a series of trigger level 
ommands being sent to the hardware. Similarily, 
hanging the verti
al

preampli�er gain settings to show the 
orresponding hardware 
ommands.

Regarding the os
illos
ope operation: For normal triggering, the host PC issues a request for an

update. When a trigger o

urs, the hardware a
quires the waveform and sends it to the host. The host

re
eives it on an asyn
hronous basis, using the fileevent 
ommand. That 
ommand then pro
esses the

data.

Debug Level

If you'd like to see more detail of the 
ommands being sent to the hardware, you 
an turn on a debugging

�ag in the software. Here's the way to do that on a Windows system:

• Open the sour
e �le dire
tory, whi
h is something like

C:\Program Files\Sys
omp\CGR101-1.17\sour
e

• Load the �le main.t
l into notepad

• �nd the line (near the beginning of the �le) that says set debugLevel 0

Change this to set debugLevel 1

Save the �le

• Run the Sys
omp software. Sele
t the menu item View -> Debug Console.

• A new window will appear, whi
h shows the 
ommands being sent to the s
ope. The s
ope is on

Auto triggering by default. Change this to normal triggering to stop the s
rolling.

The window shows only 
ommands being sent to the s
ope, not the data being returned. If you

need that, modify the sour
e 
ode with print statements for the quantities of interest.

14 Manual Operation

The os
illos
ope may be operated by sending it 
ommands from a terminal emulator. If you are 
reating

new software to 
ontrol the hardware this 
an be useful for debugging.

14.1 Windows

The Hyperterminal program that is supplied as part of Windows operating systems (previous to Win

7) is suitable for this.

1. To simplify matters, it is probably best to unplug any USB devi
es that are 
onne
ted.

2. Plug the s
ope hardware into a USB port on the 
omputer.

3. Using the steps des
ribed in se
tion 18.2.1, determine the COM port that the s
ope is 
urrently


onne
ted to.

4. Start Hyperterminal:

Start -> Programs -> A

essories -> Communi
ations -> Hyperterminal

5. Hyperterminal starts with a 'Conne
tion Des
ription' popup window. Can
el the popup.

6. Sele
t File -> Properties

7. Operate the Conne
t Using menu to sele
t the COM port that you found previously.
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8. Sele
t Configure whi
h pops up a Port Settingswindow. Most of the port settings 
an be left at

their default values, but the baud rate (Bits per Se
ond) must be 
hanged to the 
orre
t value.

At this time, the 
orre
t value is 230400. The 
orre
t port settings are:

Bits per Se
ond: 230400 Baud

Data bits: 8

Parity: None

Stop Bit: 1

Flow Control ,Hardware (RTS/CTS) Handshaking

If you have a version of the s
ope T
l program that works 
orre
tly with the s
ope hardware, you


an verify the baud rate. Load that 
ode into a text editor and look for the baud setting. Sear
h

for a variable baud or a pro
edure openSerialPort.

Hit OK and ba
k out to the hyperterminal s
reen.

9. Issue some 
ommand from the list in se
tion 13. Type it in followed by the 'Enter' key. A good


hoi
e is i, whi
h should result in a message from the s
ope indi
ating its version number.

14.2 TeraTerm: An Alternative to Hyperterminal

The Hyperterminal terminal emulator is not available with the Win 7 operating system. TeraTerm is an

open-sour
e alternative, and it's somewhat less 
onfusing to use than Hyperterminal. To use TeraTerm:

1. Download and install the TeraTerm software from Sour
eforge:

http://en.sour
eforge.jp/proje
ts/ttssh2/releases/

This should 
reate a TeraTerm i
on on your desktop.

2. Plug in the CGM-101 hardware to an unused USB port.

3. Start TeraTerm. The 'New Conne
tion' window appears. 'TCP/IP' is sele
ted by default. Change

the sele
tion to 'Serial'.

4. On that same window, sele
t 'Port'. In this 
ase, it shows COM3 and COM5: USB Serial Port.

For example, if we know the CGM-101 is 
onne
ted to COM5, sele
t COM5. Cli
k on OK. Window


loses.

5. Sele
t the menu item Setup -> Serial Port

The port has been sele
ted, no need to 
hange that.

Set the Baud Rate to 230400.

Set Data Bits to 8.

Set Stop Bits to 1

Set Parity to None

Set Flow Control to Hardware.

Cli
k on OK. Window 
loses.

6. Sele
t the menu item Setup -> Terminal

Change the New-line Re
eive to CR+LF

Change the New-line Transmit to CR+LF

Cli
k on OK. Window 
loses.

7. In the main terminal window, type the letter i followed by the Return key. You should see a

message something like *Sys
omp Advan
ed Waveform Generator V1.0/1.0.

If so, you are now 
onne
ted and 
an issue 
ommands to the generator. Noti
e that all 
ommands

are terminated by the Return key.
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14.3 Linux

For manual operation under the Linux operating system, you will need to 
ommuni
ate with the hardware

using a terminal emulator program. There are two terminal emulators in 
ommon use under Linux:

seyon and mini
om. These may not be installed as part of your linux distribution. To 
he
k whether

the program is installed, use the whi
h 
ommand:

phis
o
k�panther:~> whi
h seyon

/usr/X11R6/bin/seyon

Seyon must be properly 
on�gured to be used. This is des
ribed in the do
ument Seyon: Qui
k Start

Guide, available for download here: http://www.ee.ryerson.
a/~phis
o
k/papers/using-seyon.

pdf.

Information on using mini
om may be found at the following lo
ation:

Using Mini
om and Seyon

Chapter 11 of Learning Debian GNU/Linux

Bill M
Carty

O'Reilly Books, 1999

http://www.oreilly.
om/
atalog/debian/
hapter/book/
h11_07.html

1. Plug the s
ope hardware into a USB port on the 
omputer.

2. Run the 
ommand dmesg to identify the serial port that the is allo
ted to this USB devi
e. It may

be a few se
onds before the operating system �nishes its allo
ation, so run dmesg repeatedly until

you see the serial port number, whi
h will be something like \ttyUSB1.

3. Start the terminal 
ommuni
ations program (Seyon or Mini
om):

4. Set the port settings to:

Bits per Se
ond: 230400

Data bits: 8

Parity: None

Stop Bit: 1

Flow Control Hardware

If you have a version of the os
illos
ope T
l program that works 
orre
tly with the s
ope hardware,

you 
an verify the baud rate. Load that 
ode into a text editor and look for the baud setting.

Sear
h for a variable baud or a pro
edure openSerialPort.

5. Issue some 
ommand from the list in se
tion 13. Type it in followed by the 'Enter' key. A good


hoi
e is i, whi
h should result in a message from the os
illos
ope indi
ating its version number.

Now you 
an type in other 
ommands.

15 Modifying and Running the Sour
e Code

15.1 Preparation for Modifying the Software

The software for the Sys
omp instruments is written in the T
l/Tk language. The sour
e 
ode is

interpreted, whi
h means that there is a T
l language interpreter program present that exe
utes the T
l

sour
e 
ode. Consequently, you 
an modify the operation of the program by modifying the sour
e 
ode,

whi
h we provide.
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We provide as the install an exe
utable whi
h is ma
hine spe
i�
 (ie, there are Windows, Linux and

Ma
 versions) whi
h 
ontains the T
l interpreter and libraries ne
essary to run the sour
e 
ode. The

easiest development pro
ess is to use that exe
utable to run the sour
e 
ode.

If you want to 
hange the operation of the 
ode, then make a safety 
opy of the relevant T
l sour
e


ode �le and edit the sour
e 
ode T
l �le with any text editor.

You 
an also run the sour
e 
ode without that exe
utable, by exe
uting the 
ommand 'wish main.t
l'

(or it's equivalent on your ma
hine) in the sour
e 
ode dire
tory. If that 
auses errors, the �rst thing to do

is to download the latest version of T
l from the A
tivestate website: http://www.a
tivestate.
om/.

Then try again.

If there are further error messages 
on
erning the BWidget or Img pa
kage, you'll need to download

those as well, using these 
ommands:

tea
up install �with-re
ommends BWidget

tea
up install �with-re
ommends Img

At that point, it should be possible to run 'wish main.t
l' and make the graphi
al user interfa
e appear.

15.2 Modifying the Software

The host software for the s
ope (and other Sys
omp instruments in this series) is released in plain

text format under the GPL (Gnu Publi
 Lin
ense). Consequently, it is legal to modify the program in

whatever way you may �nd useful. We also en
ourage you to share your work with others.

The program itself is in text form. The 
ode does not need to be 
ompliled or linked, it is exe
uted

dire
tly from the text form by the wish interpreter.

Although the s
ope program is fairly 
ompli
ated, it is possible to 
reate a powerful T
l/Tk program,

with a sophisti
ated user interfa
e, with only a few lines of T
l/Tk 
ode.

To set up for development, ensure that the wish interpreter is installed on your 
omputer. Under

Linux, it is probably already there. Under Windows, you need to download and install a �le from the

A
tiveState website:

http://www.a
tivestate.
om/Produ
ts/languages.plex?tn=1

Download the appropriate .exe �le for your operating system. Run the program to install T
l/Tk.

Make a 
opy of the original 
ode, of 
ourse, and put it in a safe pla
e. Then, using a text editor,

read and modify the existing 
ode. When you want to test the 
ode, run the wish interpreter. Exe
ute

the sour
e 
ommand with the name of your �le, and the program will exe
ute. Repeat this 
y
le until

you have the desired result.

We'd like to hear about your work. Che
k out our web page for the latest 
onta
t information.

16 Installation Overview

The installation should work 
orre
tly under modern versions of Windows, Linux and Ma
intosh op-

erating systems. Installation only needs to be done on
e: thereafter, the program 
an be started by

double-
li
king on an i
on.

16.1 Windows

Download the Windows setup exe
utable from our website, www.sys
ompdesign.
om/downloads. Run

it. Everything (in
luding driver install) is automati
.

16.2 Linux

Download the Linux zip ar
hive from our website, unzip it into a folder of your 
hoi
e (where you have

permissions). Run either the Install-Linux-32-bit.sh or Install-Linux-64-bit.sh.

You may need to 
hange the permissions on those �les to get them to exe
ute. As superuser, run:


hmod 777 <�le name>
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16.3 Ma
intosh

Download the DMG image from our website, www.sys
ompdesign.
om/downloads. Open it. First, drag

the CGR-MINI i
on into the Appli
ations short
ut in the DMG. Then run the driver installer in the

DMG.

As of August 2012, Apple has added a GateKeeper fun
tion to OSX Mountain Lion and subsequent

operating systems. Gatekeeper prevents installing the Sys
omp software and generates a Defe
tive

Software message. You'll need to disable Gatekeeper while doing the download and install. A Google

sear
h for 'OSX disable gatekeeper' will show the ne
essary instru
tions.

Gatekeeper should be re-enabled on
e the installation is 
ompleted and it is veri�ed that the software

is operational.

16.4 First Time Operation

These instru
tions apply to all operating systems: Windows, Linux and Ma
.

1. Using the supplied USB 
able (or similar one of your own 
hoosing), plug the os
illos
ope into a


omputer USB port. If you have more than one USB port, you 
an 
hose any port.

2. The green LED on the hardware unit should illuminate. (Under Windows the 
omputer will make

its USB boing noise.)

3. On Windows and Ma
 ma
hines there should be a Sys
omp i
on on the desktop. The exa
t name

will vary, but it should be something like Sys
omp Cir
uitGear. Start the os
illos
ope program

by double 
li
king on this i
on. On a Linux ma
hine, run the exe
utable

4. A s
reen Unable to Conne
t to Devi
e. Examine Conne
tion Settings? appears. Cli
k on

Yes.

5. The Port Settings 
ontrol panel appears. Cli
k on Autodete
t.

6. The program s
ans through the available COM ports, 1 through 99.

7. If it �nds an available port, a noti�
ation s
reen will pop up saying something like CGM-101 found

on COM6.

If it does not �nd an available COM port, try 
li
king on Autodete
t again. If this also fails,

you'll need to set the COM port manually.

8. Assuming that the system �nds an available COM port, 
li
k on OK. A Port Settings Listing

window shows a list of the unavailable COM ports and the one that was found. Cli
k on Ba
k

9. The Port Settings 
ontrol panel shows whi
h port has been sele
ted. Cli
k on Save and Exit.

This 
auses a small text �le s
opeport.
fg to be written to the dire
tory where the s
ope program

was laun
hed. This �le 
ontains the 
onne
tion port number.

10. At this point, the Conne
ted indi
ator at the top of the GUI s
reen show show a green 
olour.

The unit is operational.

From now on, whenever you double-
li
k the program i
on, the program should start and automati-


ally 
onne
t.

17 Installation Details

In this se
tion we provide more detail of the installation pro
edure.
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17.1 Windows Installation

The installation pro
edure unpa
ks and installs the Sys
omp Graphi
al User Interfa
e (GUI) program

that intera
ts with the hardware. It also install two Future Te
hnology Devi
es International (FTDI)

virtual COM port (VCP) drivers ne
essary to 
ommuni
ate with the hardware.

S
reen shots of the install pro
edure are in �gure 19 on page 37.

1. Point your browser at the Sys
omp web site, www.sys
ompdesign.
om.

2. Navigate to the Downloads se
tion of the website. Download the software for a Windows operating

system installation. When the software download 
ompletes, �nd the downloaded �le. Exe
ute

that �le by double-
li
king on it.

3. After a brief pause, the s
reen of �gure 19(a) appears. Cli
k Next.

4. The s
reen of �gure 19(b) appears. Cli
k Next.

5. The Sele
t Start Menu Folder of �gure 19(
) appears. Cli
k Next.

6. The Sele
t Additional Tasks s
reen of �gure 19(d) appears. We re
ommend enabling Create

a Desktop I
on. Cli
k on Create a Desktop I
on until a 
he
k mark appears next to it. Cli
k

Next.

7. The Ready to Install s
reen of �gure 19(e) appears. If you are satis�ed with the install dire
-

tories, 
li
k on Install. Otherwise, 
li
k Ba
k and revise the ne
essary entries.

8. The Installing s
reen and progress bar of �gure 19(f) appears. Wait while that 
ompletes.

9. The USB Devi
e Driver install s
reen of �gure 19(g) appears. Cli
k Next.

10. The Installing drivers s
reen of �gure 19(h) appears.

11. The Congratulations! You are finished installing drivers... s
reen appears, �gure 19(i).

Cli
k Finish.

12. The Completing the Sys
omp Setup Wizard s
reen appears, �gure 19(j). Cli
k Finish.

13. The software is installed.
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(a) Wel
ome to Setup Wizard (b) Sele
t Destination (
) Sele
t Start Menu Folder

(d) Additional Tasks (e) Ready to Install (f) Installing

(g) Wel
ome to Driver Install (h) Installing Drivers (i) Finished Drivers

(j) Completing the Install

Figure 19: Windows Installation S
reens
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17.2 Ma
intosh Install

This se
tion des
ribes how to install Sys
omp instruments on a Ma
Book running OSX. These instru
-

tions des
ribe a 'one button' pro
edure for software version 1.13 and following.

You may also wish to 
he
k se
tion 18.4 on page 54, whi
h des
ribes setup for a Ma
-equipped

multiple station lab.

17.2.1 Che
king the Host Ma
hine

The Sys
omp software is interpreted by the T
l/Tk language interpreter, so it is essential that the

ma
hine is 
apable of running T
l/Tk.

The A
tiveState website (originators of T
l/Tk) indi
ate that T
l/Tk should run 
orre
tly on plat-

forms with 'Ma
 OS X 10.2+'. There is no mention of requirement for Intel or Power PC pro
essors

5

.

The �rst step is to determine that the 
omputer is 
apable of running this software. To do that:

1. Cli
k on the Apple i
on in the top left 
orner of the s
reen.

2. Sele
t 'About this Ma
'

For example, on the lo
al Ma
 ma
hine the Ma
 information is:

• Ma
 OSX 10.5.6

• 2.4GHz Intel Core 2 Duo

• 2GB 667MHz RAM

The key items are that the operating system is OSX and it's version is later than 10.2. So the software

should run on this ma
hine.

17.2.2 Installing Software

As of August 2012, Apple has added a GateKeeper fun
tion to OSX Mountain Lion and subsequent

operating systems. Gatekeeper prevents installing the Sys
omp software and generates a Defe
tive

Software message. You'll need to disable Gatekeeper while doing the download and install. A Google

sear
h for 'OSX disable gatekeeper' will show the ne
essary instru
tions.

Gatekeeper should be re-enabled on
e the installation is 
ompleted and it is veri�ed that the software

is operational.

1. Start the Ma
.

2. Plug in the Sys
omp CGM-101 hardware. The green LED on the hardware should illuminate.

3. Point your browser at the Sys
omp web site, www.sys
ompdesign.
om.

4. Navigate to the Downloads se
tion of the website. Download the software for a Windows operating

system installation. When the software download 
ompletes, �nd the downloaded �le. Exe
ute

that �le by double-
li
king on it.

5. The CGM-101 i
on appears on the desktop. Open it.

6. Open setup.htm.

7. Cli
k on Cli
k here for the DMG installer.

8. Open Cir
uitGear.dmg

5

http://www.t
l.tk/software/t
ltk/platforms.html
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9. A s
reen appears on the desktop, showing the Appli
ations folder and the Sys
omp Cir
uitGear

unit. Drag and drop the Sys
omp image onto the Appli
ations folder. A progress bar appears and


ompletes.

10. Go to the Appli
ations folder:

Finder -> Ma
intosh HD -> Appli
ations.

11. Find the entry for the Sys
omp Cir
uitGear. Double 
li
k on it. The CGM-101 GUI should appear.

It will probably show 'Not Conne
ted' in red. A dialog box will pop up saying 'Examine hardware

settings?'. Cli
k on Yes.

12. Examine the hardware settings. Sele
t the entry that says 
u-usbserial-xxxxwhere xxxx is some

serial number. The gui indi
ator should turn green and show Conne
ted.

If the GUI does not 
onne
t, exit from the gui. Unplug the CGM hardware and plug it in again.

Restart the GUI and this time the hardware should 
onne
t properly.

13. The program should indi
ate Conne
ted, some a
tivity should be visible on the s
ope tra
e, the

red LED on the s
ope hardware should �ash. The unit is operational.

17.2.3 Installing Driver

In order to 
onne
t, the USB-Serial driver must be installed on the Ma
. On some ma
hines, this is in

pla
e without further intervention. However, if you followed the previous steps and the hardware still

will not 
onne
t, you may have to download and install the driver.

1. Point your browser at this website:

http://www.ftdi
hip.
om/Drivers/VCP.htm

This is the website for the FTDI 'Virtual Com Port (VCP) driver that is needed.

2. Find and 
li
k on the driver that 
orresponds to your operating system (Ma
 OSX) and pro
essor

type (x86 or x64). At the time of writing, the same driver (2.2.17) applies to both types of

pro
essors. Cli
k on that driver number. A window will open, allowing you to download the

driver.

3. You should now have a .DMG version of the driver on your desktop. Double 
li
k on that �le to run

it. This will install the driver.

4. When that 
ompletes, restart the Sys
omp GUI software as you did before:

Go to the Appli
ations folder:

Finder -> Ma
intosh HD -> Appli
ations.

5. Find the entry for the Sys
omp Cir
uitGear. Double 
li
k on it. The CGM-101 GUI should appear.

It will probably show 'Not Conne
ted' in red. A dialog box will pop up saying 'Examine hardware

settings?'. Cli
k on Yes.

6. Examine the hardware settings. Sele
t the entry that says 
u-usbserial-xxxxwhere xxxx is some

serial number. The gui indi
ator should turn green and show Conne
ted.

If the GUI does not 
onne
t, exit from the GUI. Unplug the CGM hardware and plug it in again.

Restart the GUI and this time the hardware should 
onne
t properly.

7. The program should indi
ate Conne
ted, some a
tivity should be visible on the s
ope tra
e, the

red LED on the s
ope hardware should �ash. The unit is operational.
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17.3 Linux Installation

1. Point your browser at the Sys
omp website, www.sys
ompdesign.
om. Navigate to the Downloads

se
tion. Download the �le for the Linux operating system. Unzip that �le. Move into the dire
tory


reated by the unzip operation.

2. Change to the Sour
e subdire
tory. Copy all �les and folders from the /Sour
e dire
tory to a

suitable dire
tory on your ma
hine, for example:

/home/yourname/Sys
omp/CGM101

3. Copy the appropriate binary �le from the /Sour
e/bin/ dire
tory into the folder you sele
ted or

exe
ute the appropriate shell s
ript in the Sour
e dire
tory. For example:

sh Install-Linux-32-bit.sh

or


p /home/yourname/Sys
omp/CGM101/bin/linux/linux_ix86/CGM101-linux-x86

/home/yourname/Sys
omp/CGM101/

(The above 
ommand should be exe
uted on one line.)

4. Exe
ute the binary exe
utable to start the software. For example, use these two 
ommands:


d /home/yourname/Sys
omp/CGM101

./CGM101-linux-x86

17.3.1 Hardware Installation

1. Plug the hardware devi
e into an available USB port.

2. Run the program dmesg to show whi
h serial port the instrument has been atta
hed. For example,

/dev/ttyUSB0.

3. Start the binary exe
utable (the GUI, Graphi
al User Interfa
e) as des
ribed above.

4. On the GUI, use the Hardware-->Port Settings menu in the instrument software GUI to man-

ually 
onne
t to the serial port we found using dmesg, eg, /dev/ttyUSB0.

5. The GUI should indi
ate Conne
ted and the os
illos
ope tra
e should show a
tivity.

Note that 
urrently, Linux assigns USB serial ports in the order in whi
h the instruments are plugged

in. You may have to manually reassign the port settings in the GUI intrumentation software if multiple

usb-serial devi
es (su
h as Sys
omp Instruments) are used simultaneously. Use dmesg ea
h time you

atta
h an instrument to the 
omputer to determine its serial port assignment.

17.3.2 Optional: Running the GUI from Sour
e

You 
an exe
ute the sour
e 
ode dire
tly using the T
l interpreter wish. See se
tion 15 on page 33. For

information on the T
l language, see the appli
ation note on the Sys
omp website, Hello Button.
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18 Troubleshooting

18.1 Overview of USB Operation

In general, the operation of the USB 
onne
tion is seamless and invisible to the user. Operation of the

os
illos
ope is usually as simple as plugging it in to an USB port and running the os
illos
ope GUI

software. However, it may be useful to understand some of the details.

The USB interfa
e uses a USB-Serial 
hip FT245BM from FTDI. This 
hip, with the appropriate

driver software on the host PC, emulates a serial port. Consequently, the T
l/Tk GUI software 
an

a

ess the hardware just as if it was a

essing a devi
e 
onne
ted to the host serial port. This is orders

of magnitude simpler than dealing with USB, whi
h is extremely 
ompli
ated. We refer to this as a

USB-serial interfa
e.

The USB-serial has major advantages over the traditional serial port. First, the data transfer rate is

mu
h faster (espe
ially using the USB2.0 standard). Furthermore, power is transmitted from the host to

the hardware over the USB 
able so that an AC adaptor is not needed. Third, the USB system handles

enumeration automati
ally so that multiple devi
es are a

essed 
orre
tly without manual 
on�guration.

• Under Windows, the FTDI USB-serial drivers are automati
ally loaded by the Install program,

so the user should not normally be required to intervene.

Thereafter, the operating system always asso
iates that hardware with that serial port, even if it

is plugged into a di�erent USB port.

• Under Linux, the FTDI driver is in
luded in the Linux kernel sin
e 2.4, so it does not need to be

installed under Linux. The assignment of the USB-Serial port depends on the order of 
onne
tion

of devi
es. If you are just using one USB-Serial devi
e, then the same port will be assigned ea
h

time. If you are using multiple USB-Serial devi
es (whi
h, in general, will work 
orre
tly), then you

will need to plug in ea
h devi
e, one at a time, and run dmesg to determine the port assignment.

In Linux, the default permission of the /dev/ttyUSBx ports is set for root a

ess only, so the

permissions must be 
hanged as des
ribed under 18.3. (The x in /dev/ttyUSBx represents a

number for a ttyUSB port, something like ttyUSB0 or ttyUSB1, and so on.)

• Under Ma
 OS-X, the FTDI driver may or may not be present. If the Sys
omp software will not


onne
t to the hardware, the �rst step should be to download and install the appropriate driver

from the FTDI website, at:

http://www.ftdi
hip.
om/Drivers/VCP.htm

Noti
e that the same FTDI driver works for all versions of OS-X.

In Ma
 OS-X, the assigned USB-Serial port is a devi
e named 
u-usbserial-xxxx where xxxx is

some serial number Otherwise, the USB-Serial port assignment is similar to Linux.

18.2 Mi
rosoft Windows

18.2.1 Manually Assigning a COM Port Number in Windows XP

It may be useful to know how to set the COM port manually.

For example, under 
ertain 
ir
umstan
es, it is possible for the operating system to assign a low

value COM port that 
on�i
ts with some other non-Sys
omp devi
e. COM values COM1, COM2 and

COM3 are risky to use. Then, if the devi
e is assigned to COM3, for example, and is not 
onne
ting

properly, you should try moving it to another COM port number (su
h as COM9). (We know that


ertain Bluetooth devi
es have 
aused this problem in the past.) All COM port values up to COM99

should work 
orre
tly.

1. Plug in the problem instrument to a USB port.

2. Go to: Start -> Settings -> Control Panel -> System -> Hardware -> Devi
e Manager

3. Double-
li
k on Ports (COM and LPT). This opens to show any USB-serial port assignments. Let's

say that it shows USB Serial Port (COM3). We de
ide to move this to COM9.
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4. Double-
li
k on the entry USB Serial Port (COM3). This opens a new dialogue box, USB Serial

Port (COM3) Properties.

5. Sele
t Port Settings and 
li
k on Advan
ed.

6. This opens a new dialog box, Advan
ed Settings for COM3. In the upper left 
orner, there is

a s
rollbox COM Port Number. Use the up/down arrows to s
roll through the possible COM port

assignments.

7. For the new COM port assignment, it's best to 
hoose a COM port number 4 or larger. (Lower

numbers may 
on�i
t with a USB keyboard or mouse). Suppose we de
ide to move to COM5. The

s
rollbox says COM5 (in use). Sele
t it anyway. Cli
k OK.

8. If a warning pops up that the COM port is in use and asks if you want to 
ontinue, it's safe to


li
k on Yes.

9. Ba
k out through the menues until you have 
losed the Devi
e Manager panel. Re-open it and

examine the Ports (COM&LPT). This time it should read COM5.

10. Ba
k out to a 
lean desktop and restart the instrument program. This time, it should 
onne
t

properly.

11. If you are 
onne
ting multiple instruments, you may need to do this for ea
h instrument. However,

having on
e done the assignment for a given instrument, the operating system asso
iates that

instrument with the 
hosen COM port and 
onne
tion should be automati
.

18.2.2 Che
king the Installed Files

This se
tion details how to determine that the �les are installed 
orre
tly. This information is in
luded

here for 
ompleteness, but it should not be ne
essary to use it.

1. Double 
li
k on My Computer to obtain a s
reen like �gure 20.

Figure 20: My Computer

2. Double 
li
k on Control Panel, obtaining a s
reen like �gure 21.

3. Double 
li
k on Add or Remove Programs, obtaining a s
reen like �gure 22.

Figure 22 lists the FTDI drivers, so they are installed. Similarily, the T
l/Tk program for the unit

should be shown on the same list under Sys
omp.
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Figure 21: Control Panel

Figure 22: Add or Remove Programs

18.2.3 Obtaining Details of the USB-Serial Port

1. On the Add or Remove Programs list of �gure 22, �nd the entry System. Double 
li
k on it to

obtain the System Properties s
reen of �gure 23.

2. Double 
li
k on the Hardware tab to obtain the Devi
e Manager s
reen of �gure 24.

3. Ensure that the hardware unit (DSO-101 os
illos
ope, WGM-101 waveform generator, CGM-101

Cir
uitGear, CGM-101, et
) is plugged into a USB port.

In the System Properties, Hardware panel of �gure 24, there should be an entry Ports (COM & LPT).

Double 
li
k on that and it should open to an entry like USB Serial Port (COM4).

This spe
i�es the COM port that should be sele
ted in the T
l/Tk program in order to 
ommuni
ate

with the USB hardware unit.
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Figure 23: System Properties

18.2.4 Windows 7 Notes

The hardware and software will work 
orre
tly under 32 bit and 64 bit versions of Windows 7 operating

systems. However, we have found that 
ertain other serial-usb devi
es 
an interfere with the operation.

These hints may help.

1. Open Devi
e Manager and maximize the entry Ports: COM and LPT. Disable the devi
es that

are shown there. We know that some Bluetooth devi
es and a 
ertain Intel program (ending,

appropriately, in the phrase SOL) 
an be problems. To disable a devi
e, right 
li
k on the entry

in Ports: COM and LPT and navigate to the point where you �nd a disable button.

2. Plug in the Sys
omp hardware and verify that it appears as an entry under Ports: COM and

LPT.

3. Start the GUI program by double-
li
king the Sys
omp CGM-101 i
on on the desktop.

4. If the program announ
es that it 
annot 
onne
t, use the port sele
tion dialog to autodete
t the

port. If the port does not autodete
t, then sele
t some port manually. Sele
t a high-ish number,

something above 15 for example. The lower numbers tend to get used �rst. (It's not unusual for

autodete
t to fail and manual to work. On
e the port is sele
ted, you should never have to do that

again.)

5. At that point, the devi
e should 
onne
t. Now, if you need other devi
es, you 
an enable them

one by one to �nd where is the 
on�i
t.

If problems 
ontinue, please take a s
reen shot of the expanded Ports: COM and LPT and send it

to us and we will assist.

18.3 Linux

These troubleshooting notes are spe
i�
 to Suse Linux 9.2, but should apply in general. They also

assume a working knowledge of Linux and its variants.
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Figure 24: System Properties, Hardware (Devi
e Manager)

Overview

If the software does not operate 
orre
tly, here are some things to 
he
k. They are subsequently explained

in detail.

• The operating system is too old and does not 
ontain the ne
essary drivers for the usb-serial ports.

• The operating system for some reason is not re
ognizing the usb devi
e and assigning it to a usb-

serial port. This 
an o

ur if the usb devi
e has root ownership and permissions. The permissions

must be 
hanged to allow a user-mode program to a

ess the usb port.

• The operating system is assigning the hardware to some usb-serial port but the T
l/Tk program is

not automati
ally sele
ting that parti
ular port. You'll need to sele
t the usb-serial port manually,

using the 
ontrols in the T
l/Tk program.

• The wish program, whi
h is the interpreter for all T
l/Tk programs, is not being found by the

operating system. Lo
ate it and 
hange your path so that it is found.

• The devi
e is being re
ognized and 
onne
ts properly, but does not respond properly to 
ertain


ontrols. Use the instru
tions in se
tion 14.3 to send 
ommands to the hardware to determine how

it is fun
tioning.

1. Che
k the kernel version.

The drivers for the FTDI USB-Serial interfa
e are a standard part of the Linux kernel from version

2.4 onward. To 
he
k that you have a su�
iently modern kernel, run the dmesg 
ommand piped

to the more 
ommand.

phis
o
k�panther: dmesg | more

45



Examine the �rst few lines, whi
h should be something like this:

Linux version 2.6.8-24-default (geeko�buildhost) (g

 version 3.3.4 (pre

3.3.5 20040809)) #1 Wed O
t 6 09:16:23 UTC 2004

In this 
ase, the kernel is 2.6.8-24, so it 
ontains the FTDI drivers.

If your kernel version is older than version 2.4, you may have to upgrade the kernel or install a

driver module.

2. Install the software per the instru
tions shown in se
tion 17.3 on page 40.

3. Determine the serial port used by the USB driver. In this step, we'll use the dmesg


ommand to determine whi
h serial (COM) port is being assigned to the os
illos
ope when it is

plugged in.

Exe
ute dmesg to get an idea of the most re
ent kernel messages. Using the USB 
able, 
onne
t

the s
ope hardware to a USB port. Exe
ute dmesg again, and you should see something like this

as the last entry in the dmesg printout:

usb 4-2: new full speed USB devi
e using address 4

usb 4-2: Produ
t: USB <-> Serial Cable

usb 4-2: Manufa
turer: FTDI

usb 4-2: SerialNumber: 00000001

ftdi_sio 4-2:1.0: FTDI FT245BM Compatible 
onverter dete
ted

usb 4-2: FTDI FT245BM Compatible 
onverter now atta
hed to ttyUSB0

Unplug the USB 
able and run dmesg again and see something like this:

usb 4-2: USB dis
onne
t, address 4

FTDI FT245BM Compatible ttyUSB0: FTDI FT245BM Compatible 
onverter now

dis
onne
ted from ttyUSB0

ftdi_sio 4-2:1.0: devi
e dis
onne
ted

Evidently the USB devi
e is being assigned to devi
e ttyUSB0.

This shows that the USB devi
e is being re
ognized by the operating system and assigned to a

usb-serial port.

4. Set the permissions for the USB-Serial port

The default situation is that root is the owner of the USB serial port ttyUSB0 and operation is

restri
ted to root. For an ordinary user to a

ess the port, the permissions must be 
hanged.

First, we will show how to do this manually in se
tion 18.3.1. However, Linux is usually set up so

that the permissions revert ba
k to root mode every time the USB is plugged and unplugged, and

every time the system is rebooted. Therefore, we need to modify the system so that this is done

automati
ally, ie, so that the port permissions are set to user mode by default. This is shown in

se
tion 18.3.2 below.

18.3.1 Manually Changing Devi
e Port Permissions

Change to the /dev dire
tory.

phis
o
k�linux:~> 
d /dev

Che
k the permissions on the ttyUSB ports:
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phis
o
k�linux:/dev> ls -l ttyUSB*


rw-rw---- 1 root uu
p 188, 0 2005-11-07 18:25 ttyUSB0


rw-rw---- 1 root uu
p 188, 1 2004-10-02 01:38 ttyUSB1

<others deleted>

In this 
ase, the owner (root) has read-write a

ess. The group that root belongs to, uu
p, also has

read-write a

ess. Others (that's you) have no a

ess at all. To open up the port to user a

ess, enter

root mode using the su 
ommand:

phis
o
k�linux:/dev> su

The system asks for the root password. Enter it. Now you 
an 
hange the permissions (mode) for

the ports. In this 
ase, we'll use the 
hmod 
ommand to add read and write permission for 'others'. For

example, the �rst 
ommand below says: 
hange the mode of devi
e ttyUSB0 to add read permission for

'others'. The se
ond 
ommand does the same for write permission.

linux:/dev # 
hmod o+r ttyUSB0

linux:/dev # 
hmod o+w ttyUSB0

Che
k the permissions again:

ls -l ttyUSB*


rw-rw-rw- 1 root uu
p 188, 0 2005-11-07 18:25 ttyUSB0


rw-rw-rw- 1 root uu
p 188, 1 2004-10-02 01:38 ttyUSB1

That's it. You should now be able to a

ess those ports from user mode. Exit from root to user

mode.

In
identally, you may be able to 
hange the permissions by logging in as root and then using the

features of the KDE or Gnome desktop to 
hange the permissions.

18.3.2 Setting Default Port Permissions to User Mode: Suse 9.2

This 
hange will ensure that the serial-usb ports are always 
reated with user mode a

ess.

The default permissions for user devi
es are 
ontained the �le: /et
/udev/permissions.d/50-udev.permissions .

We have to modify the entry for the ttyUSBx ports so that the default is user mode.

1. Change to the dire
tory /et
/udev/permissions.d and 
he
k that the �le 50-udev.permissions ex-

ists.

2. If the �le exists,

6

enter root mode, and 
opy the existing �le so you have a 
opy of the original.


p 50-udev.permissions 50-udev.permissions-orig

3. Now open the �le 50-udev.permissions with your favourite editor. Find the entry that says:

ttyUSB*:root:uu
p:660

Change that to read:

ttyUSB*:root:uu
p:666

Save the �le. Now every time a ttyUSBx port is 
reated, you should be able to a

ess that port

without problems.

6

If the �le does not exist, please let us know the name of the Linux distribution and we'll look for another solution.
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18.3.3 Setting Default Port Permissions to User Mode: Suse 10.3

Suse in their wisdom have 
hanged the method dete
ting USB devi
es. Now, USB devi
es do not exist

in /dev until they are plugged in.

Plug in the DSO-101 os
illos
ope and exe
ute 'dmesg'. You should see something like the following

at the end of the message:

usb 1-2: new full speed USB devi
e using uh
i_h
d and address 2

usb 1-2: new devi
e found, idVendor=0403, idProdu
t=6001

usb 1-2: new devi
e strings: Mfr=1, Produ
t=2, SerialNumber=3

usb 1-2: Produ
t: Digital Os
illos
ope DSO-101

usb 1-2: Manufa
turer: Sys
omp

usb 1-2: SerialNumber: DSQ3Q7ZO

usb 1-2: 
onfiguration #1 
hosen from 1 
hoi
e

drivers/usb/serial/usb-serial.
: USB Serial support registered for FTDI USB

Serial Devi
e

ftdi_sio 1-2:1.0: FTDI USB Serial Devi
e 
onverter dete
ted

drivers/usb/serial/ftdi_sio.
: Dete
ted FT245BM

usb 1-2: FTDI USB Serial Devi
e 
onverter now atta
hed to ttyUSB0

usb
ore: registered new interfa
e driver ftdi_sio

drivers/usb/serial/ftdi_sio.
: v1.4.3:USB FTDI Serial Converters Driver

This indi
ates that the os
illos
ope was dete
ted and it has been assigned to the USB-Serial port

ttyUSB0.

You now go to the dire
tor /dev and examine the ttyUSB0 entry:

phis
o
k�panther:/dev> ls -l ttyUSB0


rw-rw---- 1 root uu
p 188, 0 2008-04-20 12:57 ttyUSB0

The uu
p group have read-write permission to this devi
e, so the permanent solution is to add uu
p as

one of your groups. In Suse 10.3 this is done from: Computer -> Control Center -> Open Administrator Settings.

You'll need to enter the root password.

Then go to: Se
urity and Users -> User Management -> User and Group Administration.

Sele
t the user (that's you) and 
li
k on Edit. This brings up the Existing Lo
al User page. Cli
k

on Details. Under Groups 
he
k o� uu
p. Log out and log ba
k in, or restart the 
omputer. You

should now be able to a

ess the USB port without having to 
hange its permissions.

18.3.4 Setting Default Port Permissions to User Mode: Fedora Core 6

This note

7

applies to Fedora Core 6, kernel 2.6.19-1.2911.f
6.

Look in /et
/udev/rules.d/50-udev.rules for the line:

KERNEL=="tty[A-Z℄*", NAME="%k", GROUP="uu
p", MODE="0660"

Change the mode value to 0666.

18.3.5 Running the Program

1. Change to the dire
tory where the program resides. The wish interpreter is required to run the

t
l program. It is normally in
luded with a Linux distribution, so it is probably present on your

system. You 
an �nd out by issuing the whi
h 
ommand.

phis
o
k�linux: whi
h wish

/usr/bin/wish

7

Kindly supplied to us by John Foster.
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If this doesn't turn it up, use the '�nd' 
ommand, starting at the root dire
tory '/'. If it is on the

system, then add that lo
ation to your path.

phis
o
k�linux: find . -name wish

<mu
h deleted>

/usr/bin/wish

2. Start wish.

phis
o
k�linux:~/eelab/demos> wish

3. A new small window will appear. This is the 
ontainer for any program that wish exe
utes. The


ursor remains where the wish 
ommand was run.

4. Cli
k in that window and run the 
ommand:

% sour
e main.t
l

using the 
orre
t name for the os
illos
ope program. The os
illos
ope GUI should now run 
orre
tly.

There are many other ways to start the program. For example, the 
ommand wish s
ope-101.t
l

(substitute the 
orre
t name of the t
l program) 
an be used. As well, the KDE and Gnome graphi
al

user interfa
es be used to set up an i
on on the desktop. Then 
li
king on that i
on will start the

program.

18.3.6 Ubuntu Linux Install

This se
tiondes
ribes how to install the DSO-101 os
illos
ope software on a Ubuntu Linux system. This

pro
edure was tested on an Edubuntu system, Hardy Heron, April 2008. Similar instru
tions apply to

installation of the WGM-101 Waveform Generator, CGM-101 Cir
uitGear and CGM-101 Cir
uitGear

Mini(with the 
orresponding �le names).

These instru
tions assume some familiarity with Linux. Spe
i�
ally, you must know how to use an

editor to modify �les. You should know how permissions work, and how to use the 
hmod 
ommand to


hange them. You should have some familiarity with the dire
tory stru
ture and the lo
ation of your

home dire
tory vs system dire
tories su
h as /et
 and /dev. You must know how the ls 
ommand

works.

Download and Unpa
k the Software

The software is available for download from the Sys
omp website:

www.sys
ompdesign.
om/download.htm

Use the mkdir 
ommand to reate a dire
tory on your 
omputer. In my 
ase, this dire
tory is:

/home/peter/eelab.

Cli
k on the �le Linux (x86bin) to download it to your 
omputer, 
he
k that it is in the eelab

dire
tory (�gure 25).

The �le that you downloaded is an ar
hive, from whi
h you must extra
t the �les. Right 
li
k on the

�le and sele
t Extra
t Here.

A dire
tory is 
reated with the extra
ted �les in it. Change to that dire
tory and examine the


ontents (�gure 26).

Che
k that main.t
l is present in the �le list. This is the �le to exe
ute to start the os
illos
ope

program.

Che
k that the T
l Interpreter wish is present on your ma
hine:

whi
h wish

If wish is present, the whi
h 
ommand will show the dire
tory:

/usr/bin/wish
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Figure 25: Che
king that the File has Downloaded

Figure 26: Dire
tory with Files

Sin
e /usr/bin is usually on your PATH, wish is present and should exe
ute.

Now you 
an exe
ute the DSO-101 software with the 
ommand:

wish main.t
l.

However, the os
illos
ope software will not 
onne
t properly to a USB port until the permissions are


orre
ted. That's the next step.

Con�gure Permissions on the USB Ports

Plugging a Sys
omp os
illos
ope, waveform generator or Cir
uitGear unit 
auses the system to 
reate

a 'serial USB port' at /dev/ttyUSB0. (Noti
e that this is yew-ess-bee-zero, not yew-ess-bee-oh. If you

have another usb-serial devi
e plugged in, the number might be some other digit than zero.)

This port has read-write permissions for root and for the 'dialout' group. It does not have read-write

permissions for a lowly user, so the instrument will not 
onne
t in this state.

You 
an 
hange the permissions on /dev/ttyUSB0, but the port is transient and disappears when

you shut down or dis
onne
t. So you would need to do that every time you start the instrument.

To make this permanent, add your name to the 'dialout' group. I tried to do it using the edubuntu

system administration tool, but for some reason the dialout group did not appear.

To do this the old-fashioned 
ommand-line way, use the 
ommand 'groups' to see whi
h groups you

belong to. Probably dialout does not appear. We will edit the groups �le to add you. Find the �le

/et
/group. Probably read-write permission is disabled for users on this �le as well. Make a note of

the permissions, be
ause we'll 
hange it ba
k. For example:.
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ls -l /et
/group

-rw------- 1 root root 934 2008-05-22 10:17 /et
/group

In order to edit it, 
hange the permissions to allow any user to edit that �le, using the 
ommand:

sudo 
hmod 777 group

<your password here>

ls -l /et
/group

-rwxrwxrwx 1 root root 954 2008-10-24 22:02 /et
/group

Now you 
an edit and save the �le. Load that �le into a text editor. Find the line with 'dialout' in

it. If the line ends in a 
olon, that means that no one yet belongs to this group. Add your login name.

If there already is some other login name, add a 
omma and then your login name. Here's what it might

look like with me (peter) added to the dialout group, after gabe.

man:x:12:

proxy:x:13:

kmem:x:15:

dialout:x:20:gabe,peter

fax:x:21:

voi
e:x:22:

.... and so on

Save the �le. Reboot the 
omputer. Exe
ute the groups 
ommand. You should see that you are a

member of the dialout group.

groups

peter dialout

Now you should be able to start the instrument 
ode by exe
uting wish main.t
l in the dire
tory

where main.t
l is lo
ated. The instrument should �nd and 
onne
t to the USB port.

For se
urity, you may want to return the permissions on /et
/group as they were originally, as you

noted previously. In my 
ase, giving groups and users read permission as well:

sudo 
hmod 644 /et
/group

<your password here>

ls -l /et
/group

-rw-r--r-- 1 root root 934 2008-05-22 10:17 /et
/group

Spe
ial thanks to Gabriel Guillen, who loaned me an edubuntu system for this exploration.

18.3.7 64 Bit Linux

One of the pa
kages in the Sys
omp distribution is the 'Img' pa
kage. The Img pa
kage is a T
l/Tk

library that is required for the CGM-101 software. Currently, those libraries are for a 32 bit linux

operating system. We are in the pro
ess of modifying the distribution to a

ompodate 64 bit linux, but

in the meantime here is a workaround.

Delete the existing Img �le. (The best way to do this is to rename it, so that you 
an ba
k out if this

pro
edure fails.) On
e you've deleted it, try running the software. If your T
l/Tk distribution has the


orre
t Img library it should run �ne. If not, download and install the A
tiveState T
l/Tk distribution

for 64 bit linux.

18.3.8 Running under 64-bit Sidux (Debian-based Linux)

The following notes were provided by Radio College of Canada student Gabriel:
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I am 
urrently running the software on a 64 bit Sidux (Debian based linux)

and have noti
ed that the img library (the .so files in Img13Lin) are 32 bit

only. This prevents the software from running on any 64bit linux systems.

This 
an easily be fixed by installing the img pa
kage in 64 bit.

the pa
kage name is libtk-img and 
an be installed by running:

apt-get install libtk-img

on any Debian based OS or by using the default pa
kage manager (this will

work for 32 and 64 bit systems)

Also, the Bwidget pa
kage should also be listed as a dependen
y, the pa
kage

name is bwidget (all lower 
ase)

apt-get install bwidget

will install it on the system

18.3.9 Devi
e Properties using usbview

In general, it's not ne
essary to know anything about the USB properties of the hardware in order to

use it. However, if you do want to inspe
t those properties, usbview is useful.

It is likely that you will have to install usbview from your Linux distribution disks.

On
e usbview is installed, (�gure 27) you 
an use it to determine whether a USB devi
e is re
og-

nized by the operating system USB. As a USB devi
e is plugged and unplugged, an entry appears and

disappears in the usbview window.

Cli
king on an entry opens up a list of USB properties of the devi
e.

Figure 27: Usbview

Noti
e that usbview does not indi
ate the serial port (/dev/ttyUSB2 or whatever) that the operating
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system has assigned to this devi
e. You must use dmesg for that purpose.

18.3.10 Terminal Conne
tion under Linux

It 
an be useful to 
onne
t to the hardware via a terminal emulator to 
he
k the operation of the

hardware. We used the program Cute
om under Ubuntu Linux. It should be possible to install Cute
om

under other versions of Linux.

To install Cute
om under Ubuntu Linux, enter the following 
ommands into a terminal window:

1. sudo apt-get update

2. sudo apt-get install 
ute
om lrzsz

This gets both the CuteCom and lrzsz pa
kages. The latter is not ne
essary, but allows the termi-

nal to support zmodem/xmodem/ymodem �le transfer. See: https://help.ubuntu.
om/
ommunity/

Cute
om.

Now we are ready to test the hardware.

1. Plug in the Sys
omp hardware unit.

2. In a terminal window, run the dmesg 
ommand. Look at the last few lines to 
on�rm the 
onne
tion

port. We'll assume ttyUSB0.

3. Run 
ute
om.

4. Set up the 
ute
om terminal emulator 
hara
teristi
s as follows:

• Devi
e: /dev/ttyUSB0

• Baud rate: 230400

• Data bits: 8

• Stop bits: 1

• Parity: none

• Handshake: Hardware ('Software' not sele
ted)

• Open for: Reading, writing

• Apply settings when opening

• CR,LF line end

• Char delay: 1 ms

5. In the Input window, enter an i 
hara
ter, then press the <enter> key.

6. In the upper display window, you should see a message ba
k from the hardware, su
h as:

Sys
omp Cir
uitGear V1.4

Then CuteCom is 
onne
ted to the hardware. You 
an send various messages to the hardware and

get responses ba
k, testing the 
ommands that are do
umented elsewhere in this manual.

A
knowledgement Jan Portegijs told us about CuteCom and gave us the 
orre
t settings to 
on-

ne
t.
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18.4 Ma
intosh Lab

The following notes are an edited version of install pro
edure information kindly provided by Ted Johnson

of Green�eld College. This applies to using the software in a lab environment, where everyone using the

Ma
 must be able to start the Sys
omp software.

1. Login as an administrator

2. Open Safari and go to web site www.sys
ompdesign.
om. Sele
t Downloads. Sele
t Ma
 OS X and

download.

3. When the download is 
omplete, drag the i
on (Sys
omp Cir
uitGear V1.15 or whatever it's

named) into the Appli
ations folder. Open the appli
ations folder, 
he
k that it is there and drag

an alias to the do
k.

4. Open the folder Drivers. Sele
t Ma
. Sele
t Intel. Double 
li
k on FTDIUSBSerialDriver.

Double 
li
k on the Snow Leopard pa
kage. Follow the instru
tions.

5. Get the s
ope hardware and plug into an open USB slot.

6. Cli
k on the do
k i
on SYSCOMP. Sele
t OPEN from the popup. When the Unable to Conne
t,

Examine Settings? popup appears sele
t YES. When the PORT SETTINGS popup appears, sele
t

the button /dev/
u.usbserial. Cli
k on SAVE AND EXIT.

7. If everything was done 
orre
tly a CONNECTED re
tangle will 
hange from red to green at the top

of the open window (the Cir
uitGear GUI). If not repeat step 4 again.

8. Now we need to set the permissions on the USB port so that all users 
an a

ess the port. To do

this, start the TERMINAL program. In the terminal window, type:


hmod 777 /Appli
ations/Sys
omp\ Cir
uitGear\ V1.15.app/Contents/Ma
OS/port.
fg and

hit return.

9. Signout as administrator. Sign in as a student. Put the app in the do
k and boot, and make sure

it works when the hardware is plugged in.
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19 Sour
es of Information

19.1 News Groups


omp.lang.t
l

Internet News Group

19.2 Websites

http://www.sys
ompdesign.
om

Latest information on Sys
omp instruments and supporting software.

Many useful appli
ation notes and proje
t des
riptions.
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http://www.t
l.tk/

Home of the T
l Developer X
hange. Pointers to information and software downloads.

http://www.a
tivestate.
om/

A
tiveState is a 
ommer
ial �rm that sells various programming tools provides a home for the T
l/Tk

language. Free versions of T
l/Tk are available for download from their site.

19.3 Paper

S
ripting: Higher Level Programming for the 21st Century

John K. Ousterhout

IEEE Computer magazine, Mar
h 1998

Currently at: http://home.pa
bell.net/ouster/s
ripting.html

Also at: http://www.t
l.tk/do
/s
ripting.htm

The de�nitive paper on T
l/Tk and s
ripting languages in general. Ousterhoot shows a Table of Ap-

pli
ations whi
h have been 
oded in T
l/Tk and in the C language, and the relative e�ort and time

required for ea
h implementation.

19.4 Textbooks

Pra
ti
al Programming in T
l and Tk, 4th Edition

Brent B. Wel
h & Ken Jones with Je�ery Hobbs

Prenti
e Hall PTR, 2003

The de�nitive referen
e for T
l and Tk. In
ludes CDROM with T
l and examples.

T
l and the Tk Toolkit

John K. Ousterhout

Addison-Wesley, 1994

Now somewhat dated, but a still useful introdu
tion to T
l/Tk by the inventor of the language.

Graphi
al Appli
ations with T
l & Tk, 2nd Edition

Eri
 Foster-Johnson

M&T Books, 1997

Very a

essible introdu
tory textbook.

T
l/Tk Tools

Mark Harrison

O'Reilly, 1997

Information on a number of extensions to T
l/Tk.

E�e
tive T
l/Tk Programming

Mark Harrison, Mi
hael M
Lennan

Addison Wesley, 1998

Te
hniques of design for T
l/Tk programs.

T
l/Tk for Programmers

Adrian Zimmer

IEEE Computer So
iety, 1998

An textbook on T
l/Tk with an a
ademi
 tone and exer
ises.

T
l/Tk for Dummies

Tim Webster

IDG Books, 1997
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A useful introdu
tion to T
l/Tk.

T
l/Tk for Real Programmers

Clif Flynt

A
ademi
 Press, 1999

Medium to high-level material on T
l/Tk
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